
 

 

1. Table of Contents
2. Pivot Animator .......................................................................................................................................2

2.1. Overview .......................................................................................................................................3
2.2. Getting Started .............................................................................................................................4

2.2.1. Interface at a Glance ..........................................................................................................5
2.2.2. Positioning Figures ..............................................................................................................7
2.2.3. Canvas Zoom ....................................................................................................................13
2.2.4. Figure Controls ..................................................................................................................15
2.2.5. Animation Frame Controls ................................................................................................19
2.2.6. Saving & Opening Animations ..........................................................................................22
2.2.7. Playing an Animation ........................................................................................................23

2.3. Creating Figure Types ................................................................................................................24
2.3.1. Edit Mode ..........................................................................................................................28
2.3.2. Polygon Fill ........................................................................................................................29
2.3.3. Segment Gradients ...........................................................................................................31
2.3.4. Figure Outlines ..................................................................................................................32
2.3.5. Adding Sprite Images ........................................................................................................33
2.3.6. Modifying Existing Figure Types .......................................................................................35
2.3.7. STK Files ...........................................................................................................................36
2.3.8. Window Transparency .......................................................................................................39
2.3.9. Keyboard Shortcuts ...........................................................................................................41

2.4. Onion Skins ................................................................................................................................43
2.5. Frame Inbetweening ...................................................................................................................44

2.5.1. Creating a Basic Inbetweening Sequence ........................................................................45
2.5.2. Auto-Easing .......................................................................................................................48
2.5.3. Adding Inbetween Frames to the Timeline .......................................................................50

2.6. Multi-figure Selection ..................................................................................................................51
2.7. Joining Figures ...........................................................................................................................53
2.8. Backgrounds ...............................................................................................................................55
2.9. Sprites .........................................................................................................................................58
2.10. Text Objects ..............................................................................................................................61

2.10.1. Speech Bubbles ..............................................................................................................64
2.11. Virtual Camera ..........................................................................................................................66
2.12. Options .....................................................................................................................................69
2.13. Exporting an Animation ............................................................................................................72

2.13.1. Animated GIF ..................................................................................................................73
2.13.2. Animated PNG ................................................................................................................75
2.13.3. Video ................................................................................................................................77
2.13.4. Separate Images .............................................................................................................79

2.14. Keyboard Shortcuts ..................................................................................................................81
2.15. Language Files .........................................................................................................................84
2.16. Things You May Not Know ......................................................................................................85



 

 

2. Pivot Animator
 

Help file for Pivot animator version 5.1 (2022)
 

The user friendly animator
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2.1. Overview
 
Pivot Animator is designed to be a user friendly way of creating 2D stick-man and sprite animations. The basic
concept is that objects can be easily moved and positioned by dragging handles. An animation is made up of key
frames added to the time-line, which are shown at the top of the screen. Frames can be automatically created
between the key frames to speed up the process (inbetweening). This makes Pivot very easy to use and gives the
animator full control over figure movement.

New stick figures can be created in the figure builder so that any object can be created and animated. These figures
can contain images to create very lifelike characters or objects.

An animation can be exported in a number of common formats for use on web pages or for uploading to YouTube.

With enough time and effort, some very advanced animations can be created with Pivot, despite its relative simplicity.

Minimum System Requirements

Version 5 of Pivot Animator makes use of the Graphics Processing Unit (GPU) for smooth real time graphics. It
therefore requires higher specifications than version 4 does. The minimum requirements are as follows.

•  Windows 7 with service pack 1 or later. Windows 10 is recommended.
•  A Graphics Processing Unit (GPU)
•  DirectX version 11 or later. Run 'dxdiag' from the search bar and check the DirectX Version in the System tab.
•  At least 4GB of RAM is recommended.
•  60MB of Hard Disk space for the installation files.
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2.2. Getting Started
 

The basics of creating an animation in Pivot Animator.
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2.2.1. Interface at a Glance
 

The main Pivot Animator window showing the default figure in the frame editing area
 
 
 



 

 

The figure builder window. Open by clicking 'Create Figure Type' in the main window's File menu
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2.2.2. Positioning Figures

Basic Pose and Movement
A figure consists of 'segments' (lines, circles or images) connected in a treelike structure by pivoting joints. Click
and drag the red handle at the end of each segment with the mouse cursor to rotate it around its pivot and all the
segments connected to it. Click and drag the orange 'origin' handle to move the whole figure. In this way you can
easily adjust the pose of a figure to any position you want while keeping the proportions of the figure constant.

When unselected, all figure handles will be displayed in blue. A figure can be selected by clicking on it anywhere.
Rotating the mouse wheel while holding down the Ctrl key will also change the selected figure.

Drag the orange handle of a figure to move the whole figure
 

Drag a red handle with the left mouse button to rotate the segment it's at the end of and all segment attached to it
 

Size / Scale and Rotation

   The size of a figure can be changed in two ways. You can set the scale by using the edit box control
in the tools panel on the left hand side of the main window (the default will be 100%). The value can be changed
quickly by clicking in the box and dragging left and right, or even quicker by dragging up or down. You can also
rotate the mouse wheel while the cursor is over the control. Finer adjustments of 0.1 can be made using left / right
dragging or the mouse wheel while holding the Shift key.



 

 

  You can also change the size of a figure by dragging a red handle with the left mouse button while holding
down the Alt key on the keyboard, which can be quicker. This can also be used to quickly rotate the whole figure
when more than one branch of segments is attached to the orange origin node. The figure will rotate and scale
around its origin point at its orange handle.

 Holding down the Alt and Ctrl keys at the same time while dragging a red handle will lock the scale
so that the figure will only rotate.

 Holding down the Alt and Shift keys at the same time while dragging a red handle will lock the rotation
so that the figure will only scale.

Drag a red handle while holding the Alt key to rotate and scale the whole figure

Segment Stretching
In some cases it may be useful to adjust the length of a single figure segment on its own.

  This can be done by holding down the Ctrl key on the keyboard while dragging a red handle. The segment
handle will then follow the cursor position without being constrained to its default length. This can be useful for
creating realistic movements for deformable or stretchy objects as well as creating the effect of 3D movements.



 

 

Drag a red handle while holding the Ctrl key to stretch a segment

If Ctrl dragging a segment from a non-default length (the length that the figure type was designed with), then it will
snap back to its default length when the cursor is close enough. It won't snap to the default length if the drag is
begun from the default length. If the segment is a non-default length and you wish to position the segment close to
the default length then it will require two drags of the handle. Firstly drag the handle so that it snaps to the default
length, then release the mouse and drag again to the length you require. Snapping does not happen in the figure
builder because that's where the default segment lengths are defined.

Handle Repositioning
A handle can be moved so that only that handle and the adjoining segments are changed. No other handle will be
affected. This may vary the length of the adjoining segments. This is equivalent to Edit Mode in the Figure Builder.
This is different to the Ctrl key which will also move the handles of other segments attached to the one being edited.
Also, unlike the Ctrl key, segments will not snap to their default length.

   This is done by holding the R key while dragging any handle.

Drag any handle while holding the R key to reposition a handle without affecting other handles

Line Segment Bending
Line segments can be bent into an arc by dragging a red handle while holding the right mouse button. The angle of
the line at its pivot and the length of the line will not change. This can only be performed with line segments. This
method can be used to create smooth continuous curves when several segments are chained together.



 

 

Drag a red handle with the right mouse button to bend the line
segment it's at the end of and rotate all segments attached to it

 
If bending a line from a non-default bend angle (the bend that the figure type was designed with), then it will snap
back to its default bend angle when the cursor is close enough. It won't snap to the default bend if the drag is
begun from the default bend. If the line has a non-default bend and you wish to position the segment close to the
default bend angle then it will require two drags of the handle. Firstly drag the handle so that it snaps to the default
bend, then release the mouse and drag again to the bend angle you require. In the figure builder window, snapping
always returns the bend angle to 0 (no bend).

 

  Line bending can also be combined with stretching by holding the Ctrl key while dragging with the right
mouse button. The angle of the line at the pivot point will not change but the bend angle and segment length will
change to keep the handle under the cursor.

  Line bending can also be combined with handle repositioning by holding the R key while dragging with the
right mouse button. This works differently to the Ctrl key because the angles at the handle being moved won't
change, whereas the length, bend and angles at the opposite ends of the attached segments will change. This
makes it easier to keep a smooth curve at the handle being positioned.

 
 
 

Fine Positioning Using the Arrow Keys

  Figures can also be positioned accurately by using the arrow keys to move the selected figure or
figures in 1 pixel increments. If the cursor is positioned over a red handle, then this will have the affect of rotating
the segment in 1 pixel increments instead of moving the whole figure. The cursor won't move with the handle, but
the arrow keys will continue to move that segment until the cursor is moved.

Even finer positioning using the arrow keys can be achieved by first zooming in. For example, zooming to 400%
and pressing an arrow key to move a figure is equivalent to moving the figure by a quarter pixel.

Segment Alignment to Horizontal / Vertical
Figure segments can be aligned to horizontal or vertical (right, left, up and down) by placing the mouse cursor over
the corresponding red handle, holding the Shift key and pressing an arrow key.



 

 

Place the cursor over a red handle, hold the Shift key and press one of the arrow keys to align the segment
 

 
Input Values
Sometimes it may be useful to set figures or segments into a specific pose that would be difficult to do only by
dragging with the mouse. This may include angles that are not up, down, left or right and so cannot be set using
the alignment feature with the arrow keys.

  The solution is to position figures to specific values by clicking 'Input Segment Values' or 'Input Object
Position' in the Edit menu or by using the 'I' keyboard shortcut. In the figure builder this will edit the selected
segment. In the main window this will edit the segment for the red handle under the cursor or the figure position
for the orange handle under the cursor. If there is no handle under the cursor then it will edit for the last handle
clicked or the selected figures. The angle, bend angle and length, or figure x and y position and z-order, can then be
modified and the figure will update as the changes are made. Angle ranges from -180° to 180°, which corresponds
to a segment pointing to the left (0° is directly to the right). The segment thickness is also shown if editing in the
figure builder. Values can be typed in or increased or decreased by dragging in the boxes or using the mouse wheel
over the box. Hold the Shift key to make finer adjustments using the mouse wheel or dragging. The Tab key can
be used to step through the values. Note that segment length cannot be set to 0 since this may make it impossible
to select the segment again. Click the OK button to apply the changes and close the window or click the cross in
the top right corner to close the window and undo any changes that were made. The same trick can be used to
position the virtual camera.



 

 

 
Select 'Input Segment Values' from the Edit menu or press the 'I' key to manually enter values for a segment.

This makes it easy to create perfect shapes such as this equilateral triangle.
Note that this can also be used in the main window.

 
 

Handle Alignment to Neighbouring Frames
When positioning figures it is often important to keep a particular handle in position relative to the previous or next
frame. This is most useful when positioning the foot of a walking or running person to prevent the foot appearing
to slip on the ground. To align a handle accurately you could zoom in to position the handle accurately relative to
the onion skin, however this takes time and is not perfectly accurate.

  The quick and easy solution is to place the cursor over the handle you want to position and press the L key
(Locate). This will move the whole figure so that the handle is positioned in the same place as in the previous frame.
Shift+L can be used to locate the handle based on the next frame if editing a frame in the middle of the animation
sequence. This only works if a figure with the matching ID is present in the previous / next frame. If a joined figure
is positioned in this way then the whole joined group will move to align the handle. The same trick can be used to
align the virtual camera to the previous or next frame.

 +   Handle alignment can be combined with the R key to move only the handle under the cursor to the
previous or next frame. Hold down the R key first and then press the L key. This may change the length of the
segments joined to the handle under the cursor.
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2.2.3. Canvas Zoom
 
Canvas zoom allows you to easily navigate around the canvas and zoom in to make it easier to position figures
accurately. When zoomed out of a complex frame containing many figures it can often be difficult to drag the correct
handle, especially if the handles are small due to short segments. Zooming in solves this problem since the handles
never exceed the maximum size. It's also possible to zoom out to less than 100%, which can be useful if using
large animation dimensions.

Note that changing the canvas zoom does not directly affect the frame being edited. Use the Virtual Camera to
achieve camera zoom and pan affects in the animation.

Canvas zoom works in exactly the same way in the Figure Builder window, making the creation of detailed figures
much easier. The pan and zoom of the main canvas can even be set to follow the pan and zoom of the figure builder
window when in transparent mode by using the Match Canvas Pan/Zoom option in the Figure Builder View menu.
 

The basic canvas zoom and scroll controls after zooming in to 400%
 
 

Navigation Using the Middle Mouse Wheel Button
 
 
 

Zooming and scrolling around the canvas can be achieved quickly using only the middle mouse wheel button.



 

 

Rotating the mouse wheel up and down results in zooming in and out respectively. The zoom level can
be seen as a percentage in the lower right hand side of the status bar. The position of the cursor affects the
center of the zoom such that the cursor will remain in position relative to the animation objects.

Dragging the canvas while holding down the mouse wheel or middle mouse button results in moving the
canvas. This is equivalent to dragging the scroll bars but will result in the cursor staying in position relative to
the animation objects. This can also be achieved by holding down the space bar while dragging the canvas
with the left mouse button.

 
 
View Menu Controls
The View menu offers various options for quickly setting the zoom or scroll of the canvas.
The keyboard shortcuts (+,- and F1-F6) can also be used at any time.
   Shortcut

Zoom In Equivalent to rotating the mouse wheel up +

Zoom Out Equivalent to rotating the mouse wheel down -

Zoom 100% Return to the default 100% zoom level F1

Zoom 200% Zoom to 200% F2

Zoom 50% Zoom to 50% F5

Zoom Selected Zoom and pan to fit the selected figure or figures within the visible canvas area F3

Zoom Animation Zoom and pan to fit the animation area within the visible canvas area F4

Zoom Camera Zoom and pan to fit the virtual camera viewport within the visible canvas area F6

 Reset Zoom While
Playing

The canvas zoom will reset to 100% while playing the animation if enabled. It will
return to its previous state when the animation is stopped.

 

 
 
Figure Positioning Using the Arrow Keys

  Figures can also be positioned accurately by using the arrow keys to move the selected figure or
figures in 1 screen pixel increments regardless of the zoom level. If the cursor is positioned over a red handle, then
this will have the affect of rotating the segment in 1 screen pixel increments instead of moving the whole figure.
This means that finer than 1 animation pixel positioning can be achieved by first zooming in. For example, zooming
to 400% and pressing an arrow key to move a figure is equivalent to moving the figure by a quarter pixel.
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2.2.4. Figure Controls
 

Buttons on the left hand side of the main window can be used to add new figures to the editing area and modify the
current selected figure or figures. Hover the mouse cursor over a button to see what it does and the corresponding
keyboard shortcut. A figure can be selected by clicking any of its handles. Multiple figures can be selected by
holding shift while clicking a figure, by dragging a box around the origin handle of figures or by using Select All
Figures from the Edit menu (Ctrl+A).

   The selected figure can also be changed by holding down the Ctrl key while pressing the
left or right arrow keys or by using the mouse wheel while pressing the Ctrl key. The selected figure will then step
through the figures.

From top to bottom the figure controls include:

  Add Figure
Add a figure to the animation. If there's more than one figure type in the animation then the figure type selector
window will appear (see below).

  Delete
Delete the selected figures.

  Edit
Open the selected figure in the figure builder window. If a text object is selected then it will open in the text window.

  Centre
Move the selected figures to the centre of the animation area.

  Flip
Flip or mirror the selected figures horizontally. Flip the figures vertically by holding the Ctrl key.

  Colour
Change the colour of the selected figures using the colour selector. If a multi-coloured figure has had its colour set
in this way then the button will be highlighted and clicking the button again will return it to its default multi-coloured
state. See the colour selector section at the bottom of this page for more info.

  Join / Unjoin
Join the selected figure to another figure. The button is disabled if multiple figures are selected. The origin handle
of the selected figure can be joined to any other joint if it doesn't result in a closed loop of joined figures. After
clicking the button, click one of the white handles to join the figure. Select the figure again and click the button
again to unjoin them.

  Raise
Move the selected figures in front of all other figures. If the Ctrl key is held then the selected figures will be raised
by one layer only. The keyboard shortcut for raising a figure is Shift key + Up arrow.

  Lower
Move the selected figures behind all other figures. If the Ctrl key is held then the selected figures will be lowered
by one layer only. The keyboard shortcut for lowering a figure is Shift key + Down arrow.

 Copy



 

 

Copy the selected figures. They can then be pasted into the same or any other frame or even into a different
animation. The keyboard shortcut is Ctrl+C. Copied figure are independent of the OS clipboard and are stored even
after the program is closed.

 Paste
Paste the figures that were copied using the Copy button. The keyboard shortcut is Ctrl+V.

  Scale
The percentage scale change of the figure from its default size. If multiple figures are selected, then the value
shown is that of the first selected figure and all selected figures will be scaled to maintain their relative proportions.
The value can be changed quickly by clicking in the box and dragging right or left, or even quicker by dragging
up or down.

 Opacity / Transparency
The percentage opacity / transparency of the selected figures in the range 0-255. The current value will be shown
as a percentage as the value is changed. The value can also be seen by hovering the cursor over the control. The
arrow keys can be used to change the value in small increments after clicking on the control. The value can also
be changed in the colour editor after clicking the colour button.

  Duplicate Figures (Edit menu)
Create an exact copy of the current figures and add them to the editing area. All properties of the figures are
duplicated where possible. This does the same as copy and paste but places the new figures in a different position
so that you know they've been duplicated. The keyboard shortcut is Ctrl+D.

Actions on Multiple Frames

Many figure actions can also be performed on multiple frames at once to save time. This includes paste figures,
move figures, delete figures, set figure colour, set figure transparency, set figure scale, raise / lower figures and
join / unjoin figures. If any of these actions are performed while multiple frames are selected then a message box
will appear to ask if you would like to apply the change to the selected frames. Select Yes to complete the multi-
frame action or No to only apply the action to the frame being edited.

Actions are applied only for figures with the matching ID (which is shown in the info bar at the bottom of the screen
for the selected figure). When moving figures, the positions of figures in the selected frames will be offset by the
distance moved so that they keep their positions relative to each other.

Note that multi-frame actions cannot be undone, so it's a good idea to save the animation beforehand just in case
the result does not match expectations.

To select multiple frames see Selected Frame Controls.

Adding Figures to the Animation

Figures can be added to the animation from an STK file by clicking 'Load Figure Type' in the File menu. Sprite
figures can be added by clicking 'Load Sprite Image'.

STK figure files can also be dragged to the animation canvas from Windows Explorer. This also works with multiple
selected files.

Figures can also be designed and added to the animation using the Figure Builder. Open the figure builder by
clicking 'Create Figure Type' in the File menu or by clicking the Edit button to edit the selected figure. Once a figure
has been designed, add it to the animation by clicking 'Add to Animation' in the figure builder File menu.



 

 

Text objects can be added by clicking 'Create Text Object' in the File menu.

Figure Selector

The figure selector can be accessed by clicking the 'Add Figure' button when there is more than one figure type in
the animation. It displays images of all figure types in the animation that have been created using the figure builder
or text designer or loaded from STK files. By clicking a figure type image, a figure of that type will be added to
the frame editing area. Hover the mouse cursor over an image to read the full name of the figure type. The figure
selector window is resizable. Double click a figure and the figure selector window will close after adding the figure.

The figure selector also allows you to search for a figure type by name. Simply click the search box and start
typing. Any figure type name containing the search term will be highlighted with bold text while all others will be
greyed out. The scroll of the window will also automatically shift to the first highlighted item.

The Rename button allows you to modify the name of existing figure types. This can be useful if you have a large
number of figure types and want to make searching easier. Click the Rename button and then click a figure to
rename. A naming window will then appear. Note that you cannot rename the Default figure type (first item) and
names must be unique, so a message will be shown and renaming will fail if another figure already contains the
new name.

The figure selector window, showing the default figure
and sprite (image) figures.

 
 

Colour Selector
 
The colour selector is used anywhere where a colour can be selected, including the figure colour button mentioned
above, the segment colour button in the figure builder, the text colour options in the text editor and the background
colour options in the background colour editor. Using any of these will show the colour selector window, where
colours can be selected in a number of ways.



 

 

The colour selector window with pure opaque red selected
 

The Basic colors section shows some commonly used colours, which cannot be changes. Custom colors can be
added to by selecting a colour and clicking 'Add to Custom Colors', or by right clicking a particular custom colour.
The custom colour is then stored in the next available slot, or the clicked slot if right click was used, and will remain
there after closing and reopening Pivot. Hovering the mouse cursor over a colour will show the colour's hex code.
Clicking a colour will select it. Click OK to close the window and apply the change.

Colours can be adjusted using the controls on the right hand side. The upper right hand side allows you to vary
brightness and saturation of the current colour by dragging the circular handle. Hue can be adjusted using the slider
on the right. The colour can also be entered manually into the boxes below by setting Hue, Saturation, Luminance
or Red, Green, Blue in the range 0 to 255. The 6 character hex code can also be entered in the Hex box where the
first 2 digits represent Red, the second 2 Green and the final 2 Blue. Hex codes are commonly used in web design
and can be copied and pasted from websites such as this one.

Opacity / transparency can also be set to give your figures, text or backgrounds a translucent quality. This can be
done by dragging the horizontal slider or by entering a value in the Opacity box, where 0 is fully transparent and
255 is fully opaque. Note that the transparency of selected figures will only be updated if the value was change in
the colour selector. This makes it possible to change the colour of multiple selected figures without altering their
transparencies.

  The colour picker / eye dropper tool can be used to select a colour from anywhere else on the screen. This
is useful for matching the colours of other animation objects or even objects from other windows or from images
on the internet. Clicking the button will cause the colour selector window to disappear temporarily. The cursor can
then be moved around and the current colour under the cursor will be shown in the square box next to the cursor.
Clicking will select that colour and the colour selector window will reappear.
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2.2.5. Animation Frame Controls
 

An animation can be created by creating a series of frames or key-frames, where each frame differs slightly from
the previous.

  After moving and editing your figures from their previous positions, click the 'Add Frame' button to
add it to the time-line. The 'A' or space bar keyboard keys can be used as a shortcut/hotkey.

The time-line, showing a selected frame and the right-click popup menu

The time-line shows all the frames in the animation at the top of the main window. The scroll bar underneath the
frames can be used to view any part of the animation (if the number of frames exceeds the width of the window).
The position of the time-line can be moved in one frame increments by clicking the arrows at either end of the time-
line or using the keyboard arrow keys when the scroll bar has focus.

The area to the left of the time-line key-frames shows the number of the frame being edited or added and the
number of inbetween frames.

Hovering the cursor over the Frame number text will show the time of the current selected frame in the animation
based on the current frame rate.

Inbetweens
The value entered in the Inbetweens edit box determines how many frames should be automatically created
between the selected key-frame and the following key-frame when the animation is played or exported. Any
differences between the selected frame and the next will vary smoothly while playing. The smoothness, speed and
duration of the inbetween sequence will depend on the chosen inbetweens value. The inbetweens value between
each pair of key-frames is represented as a green bar in the timeline, which can also be dragged as a slider to
change the value. Only the slider handle is shown when the inbetweens value is 0.

The inbetweens box replaces the Repeat box present in previous versions. To create a pause in the animation with
no change simply create two identical frames (right click and select Insert) and then set the inbetweens value of
the first frame based on how many times you'd like it to repeat. This is done automatically when loading animations
created using previous versions that contain frame repeats.

See the Frame Inbetweening page for more information.

Editing Frames

Frames in the time-line can be edited by clicking on them. The main editing area will then show the edited frame
and the Add Frame button will change to 'Update Frame'. After editing the frame the changes can be stored by
clicking the 'Update Frame' button or by selecting another frame in the time-line to edit. If you edit a frame and do
not want to keep the changes, then you can discard the changes by clicking the same frame in the time-line that
was being edited (this action cannot be undone but you will get a warning message).



 

 

  The < and > keyboard keys can be used to step the frame being edited left or right from the current
frame being edited. This is equivalent to clicking a frame to the left or right of the current frame being edited and
can therefore be combined with the Ctrl and Shift keys to select multiple frames, as described below.

Selected Frame Controls

Frames can be selected by clicking on them in the same way as editing a frame. Selected frames are displayed
with a blue border.

  Multiple frames can be selected by using the Ctrl or Shift keys in the same way as selecting
multiple files in Windows Explorer. Click a frame while holding the Ctrl key to switch the frame between selected
and unselected. Click a frame while holding the Shift key to select all frames between the clicked frame and the
previous frame clicked. The Multi Select option in the timeline right click menu can also be used and behaves as
if the Shift key was being held.

Actions on Multiple Frames
The background image or frame inbetweens value can be set for multiple frames by selecting the frames as
described above, setting the background or inbetweens value for the last frame that was clicked and then storing
the changes by clicking the 'Update Frame' button or by selecting another frame in the time-line to edit.

Other actions can also be performed on multiple frames to save time. This includes paste figures, paste camera,
move figures, pose camera, delete figures, set figure colour, set figure transparency, set figure scale, raise / lower
figures and join / unjoin figures. If any of these actions are performed while multiple frames are selected then a
message box will appear to ask if you would like to apply the change to the selected frames. Select Yes to complete
the multi-frame action or No to only apply the action to the frame being edited. Figure based actions are applied
only for figures with the matching ID (which is shown in the info bar at the bottom of the screen for the selected
figure). When moving figures or the virtual camera, the new pose in the selected frames will be offset by the amount
moved so that they keep their positions relative to each other. Note that multi-frame actions cannot be undone, so
it's a good idea to save the animation beforehand just in case the result does not match expectations.

The three buttons to the left of the time-line frames allow you to delete or copy the selected frames or paste
previously copied frames. The delete and copy buttons will only be enabled when at least one frame is selected.

  Delete Selected Frames
Click the delete button to delete all selected frames. This action cannot be undone and so a warning message will
appear to ask if you want to delete the selected frames or cancel.

  Copy Selected Frames
Click the copy button to copy the selected frames. The frames can then be pasted to the end of the animation or
inserted between frames in the time-line. Copied frames are independent of the OS clipboard and are stored even
after the program is closed.

  Paste Copied Frames
Click the paste button to paste previously copied frames to the end of the animation. The frames can have been
copied from the current animation or from another animation. Frames can be pasted from an animation with different
dimensions, but if background images are used they will either be cropped or padded out. Backgrounds and figure
types from the pasted frames will be merged with those in the existing animation to avoid duplicates where possible.

Right Click Frame Controls



 

 

Right clicking any frame in the time-line displays a pop-up menu, which provides operations that will be applied
to the clicked frame.

  Insert
Click the insert button to insert a new frame in-front of the frame that was clicked. The new frame will be an exact
copy of the clicked frame. After inserting a frame, the new inserted frame will be selected for editing.

  Paste Insert
Click the paste insert button to paste previously copied frames immediately before the clicked frame. In all other
ways, this is the same as the 'Paste Copied Frames' button described above.

  Delete
Click the delete button to delete the clicked frame. This action cannot be undone and so a warning message will
appear to ask if you want to delete the frame or cancel.

Multi Select
Click the multi select button to select all frames between the last selected frame and the frame that was right clicked.
This is equivalent to clicking the frame while holding the Shift key. This button will only be enabled if a frame was
previously selected and is not the frame that was right clicked.

Previewing a Frame

 + 

Sometimes it can be useful to view the current frame without handles to see what it would look like, but without
playing the animation so that you can inspect the frame carefully. This can be done by holding the Ctrl key while
clicking the play button. Stop previewing by clicking the Stop button or by clicking anywhere on the editing canvas.
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2.2.6. Saving & Opening Animations
 

  PIV Files
Pivot animations can be saved in the native PIV file format. In this format the animation can be opened in Pivot to
be played or edited at a later time. All the information required for the animation is contained within the PIV file, and
so the file can be emailed or uploaded to someone else with Pivot where it can be played or edited by them. PIV
files are only supported by Pivot Animator and not by video editors or YouTube.

Piv files are always backwards compatible, meaning that files created with all previous versions of Pivot can be
opened in newer versions. However, the reverse is not always true. A file created in a particular version cannot be
opened in a previous version if the first digit of the version number is different. For example, a piv file created in
version 5.x.x cannot be opened in version 4.x.x (an error message will be shown).
 
Saving an animation

  After creating an animation by adding frames to the time-line, the animation can be saved by clicking 'Save
Animation As' in the File menu. The save file window will then appear to enable you to choose a name and location
for the PIV file. Click 'Save' to finish saving. After making further changes to the animation, the PIV file can be
overwritten by clicking 'Save Animation' in the File menu or by using the keyboard shortcut Ctrl+S. A '*' symbol will
be shown in the main window title when the current animation is in an unsaved state.

The name of the animation will be shown in the main window title bar after saving.
 
Opening an animation

  A PIV file animation can be opened by clicking 'Open Animation' in the File menu. The open file window will
then appear. Navigate to the file, select it and click 'Open'. If the animation is long or contains many backgrounds
images or sprites, then it may take several seconds to open.
An alternative method for opening a PIV file is to double click it in Windows Explorer. This will start the program
and open the animation.

The name of the animation will be shown in the main window title bar after opening.
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2.2.7. Playing an Animation
 
After adding frames to the time-line, the animation can be played by clicking the Play button in the player controls.
Stop the animation by clicking the Stop button to continue editing your animation.

If an existing frame is being edited, by clicking on a frame in the time-line, then the animation will begin playing
from that frame instead of from the beginning.

When an animation is playing, you will see the animation as it will appear when exported. The figures will not have
handles and the area outside the dotted box containing the animation area will not display anything.

The canvas zoom will reset to 100% while playing if Reset Zoom While Playing is enabled in the View menu. It
will return to its previous state when the animation is stopped.
 

 
  Play the animation from the beginning or from the frame being edited. Shortcut 'P'. Use the Ctrl key to preview

the current frame being edited.

  Stop playing the animation and return to the current frame being edited. Shortcut 'S'. Clicking anywhere on the
editing canvas will also have the same effect.

  Loop the animation when playing so that it starts playing from the beginning when it reaches the end. If
unselected, the player will stop when it reaches the end of the animation and the screen will return to the current
frame being edited. When selected, the Stop button must be clicked to stop the player.
 

  Set the playing speed of the animation. The frame rate in frames per second (fps) can be seen by hovering
the cursor over the bar or when changing the value. The value ranges from 7 fps (slow playing) to 33.3 fps (fast
playing). When exporting an animation as an animated Gif or AVI video, this value will be used to set the frame rate
of the exported file. The value persists after closing and reopening the program.

The value can be changed in small increments by using the arrow keys after clicking the control.

A good tip for making good animations is to make the movement of figures smooth by making small movement
between frames so that you can set the frame rate quite high. The default value is 12 fps since this results in fairly
smooth movement without requiring very small movements and a large number of frames. If using inbetweening
then the playing speed can be set higher without the need to create very small movements between frames.
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2.3. Creating Figure Types
 
A new figure can be built using the figure builder window. Click 'Create Figure Type' in the File menu to open the
figure builder window or click the Edit Figure button to edit the selected figure. Click 'New' in the figure builder to
start a new figure.
 

The figure builder window
 
Figure types are built from lines or circles, called segments, and additionally polygons. After building a figure type,
it can be saved as an STK file from the File menu to share with others or use later. It can also be added directly
to the animation by clicking 'Add To Animation' in the File menu and giving the figure a unique name, which will
identify it in the figure selector. A unique name will be generated automatically if left blank.

While building a figure, actions can be undone using the undo and redo buttons in the edit menu. The figure can
also be positioned using the same methods as described in the Positioning Figures section, including stretching
segments using the Ctrl key and bending lines using the right mouse button.

Information about the selected segment or polygon is displayed at the bottom of the window. This includes the
segment type, thickness, length, angle and whether the segment is static or dynamic (see Remove / restore handle
below) and the draw order (z-order). The total number of segments and polygons is shown in the title bar at the
top of the window.

The selected segment is shown with a red end point handle, while all other segments have blue handles.

 
Figure Building Controls
 
The controls for building a figure are to the left of the window and are as follows:
 

  Add a circle



 

 

Add a circle segment to the figure type. After clicking the button, click any of the handles to select the joint it should
pivot on and then click anywhere to set the length and angle of the segment.
 

  Add a line
Add a line segment to the figure type. After clicking the button, click any of the handles to select the joint it should
pivot on and then click anywhere to set the length and angle of the segment.
 

Add a polygon
Add a polygon to the figure type by connecting previously created handles. This is useful for filling areas between
segments with solid areas of colour. After clicking the button, begin clicking handles in order to create the polygon.
Finish by clicking the first handle again or clicking the polygon button. A polygon must join a minimum of 3 handles.
Polygons will stay connected as the segments they connect to are moved.
 

  Duplicate segment
Duplicate the selected segment. After clicking the button, click on any of the handles on the figure to select the joint
the new segment should pivot on. Holding the Ctrl key while clicking the duplicate button will mirror the duplicated
segment, or branch if the Shift key is used (see below).
 

  Change segment kind
Toggle the selected segment between a line and a circle. All other segment properties will remain unchanged.
 

  Change circle fill
Toggle the selected segment between the three types of circle fill. These are; solid white, clear (no fill) and solid.
The solid fill will be the same colour as the figure when changed in an animation, but the white fill will always remain
white (as it was in Pivot v2). The button is only enabled when the selected segment is a circle.
 

  Change the end cap of a line segment
Toggle the selected line segment between round end caps and square. The default is round. The button will not
be enabled if a line segment is not selected.
 

  Change segment thickness
Change the line thickness of the selected segment by 1 screen pixel. Hold down the Ctrl key while clicking and
the thickness will change by 5 pixels for more rapid adjustment. A line of zero thickness will be invisible when
unselected and when used in the animation. Zoom in before changing the thickness to make finer adjustments.
 

  Remove / restore handle
Make the selected segment 'static' or 'dynamic'. A static segment will not have a handle at its end point when the
figure has been added to the animation editing area. All segments are dynamic by default. A static segment will
have a grey handle when not selected and a white handle when selected. This is useful when building detailed
figures to reduce handle clutter.
 

  Set origin joint
Set the end-point of the selected segment as the origin joint. The origin joint is the point that all other segments
branches attach to and shows the orange handle for moving the figure. Changing the origin joint is particularly
useful when repositioning the handles for joining figures at a specific point.
 

  Split segment
Split the selected segment into two segments by inserting a new joint at the segment centre. The resulting two
segments will have the same properties as the original segment but will be half the length.



 

 

 

   Delete segment or polygon
Delete the selected segment or polygon. If the segment has other segments attached to its end-point, then those
segments will drop down to the pivot-point of the deleted segment. If a polygon is joined to deleted segment and
results in the polygon having fewer than 3 connections then it will also be deleted.
 

  Colour segment or polygon
Set the colour and opacity of the selected segment or polygon by opening the colour selector. The current colour of
the selected segment or polygon is shown on the button. Hold down the Ctrl key while clicking to set the gradient
colour of the selected line or circle segment.
 

  Flip / Mirror the selected segment
Flip the selected segment horizontally or vertically using the Ctrl key. This is especially useful for mirroring sprite
image segments, which cannot be done by rotating alone.
 

  Raise segment or polygon
Raise the selected segment or polygon above everything else or raise by one object using the Ctrl key. The draw
order (z-order) of the selected segment or polygons can be seen in the status bar at the bottom of the window.
 

  Lower segment or polygon
Lower the selected segment or polygon below everything else or lower by one object using the Ctrl key. The draw
order (z-order) of the selected segment or polygons can be seen in the status bar at the bottom of the window.
 
 
Operations on Branches
 

  +      
Holding the Shift key while using most of the segment attribute buttons will change the property for the selected
segment, but also all segments and polygons connected above it (i.e. the whole branch). This is true of the Duplicate,
Circle fill, End cap, Thickness, Remove handle, Split, Delete, Colour, Mirror, Raise and Lower controls. This can
save a lot of time when editing a figure. When the Shift key is pressed you will see all the segments in the the
selected branch displayed with red handles.

If colouring, duplicating or deleting a branch containing a polygon, then the polygon will be included in the operation.

Selected Segment Highlighting

The selected segment is always shown with a red end point handle, while all other segments have blue handles.
However, the selected segment can also be highlighted in blue by selecting 'Highlight Selected Segment' from the
View menu or by using the F12 keyboard shortcut. The path of segment from the selected segment to the orange
origin handle is also shown. This can be useful when working on a complex figure with many overlapping segments.
However, it will hide the colour of the selected segment. This option persists after closing and re-opening Pivot.



 

 

The figure builder window with selected segment highlighting enabled.
The selected segment is shown in blue and the path to the origin is shown as a line.
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2.3.1. Edit Mode
 

Edit Mode can be enabled and disabled from the Edit menu. A tick will appear next to the Edit Mode menu item
when enabled and 'Edit Mode' will be shown at the top of the window.
 

 
When Edit Mode is enabled, the figure joints can be repositioned by dragging the handle without effecting the
position of any other joint. The length of the segments connected to the moved joint will therefore change.

When Edit Mode is disabled, the figure can be moved as a normal figure - this includes the use of the Ctrl key to
change the length of a segment and the Alt key to scale or rotate the entire figure.

  Holding the R key while dragging a handle is equivalent to dragging a handle while in Edit Mode but can be
used at any time and even when positioning figures in the main animation window.
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2.3.2. Polygon Fill
 

  An area between segment handles can be filled with a polygon by clicking the polygon button and then clicking
handles to create the connections. The handles will be highlighted in red as they are selected. Finish creating the
polygon by clicking the first handle again (highlighted with a black dot in the handle) or by clicking the polygon button
again. A minimum of 3 connections is required to create a polygon and the same connection cannot be added more
than once. A polygon cannot be created if it has the same connections as an existing polygon.

Polygons are useful for filling large areas and for creating stretchable regions that move with the segments.

 It can be tedious to add polygons with a large number of connections by clicking each connecting handle.
The process can be performed much more quickly by holding the Ctrl key while clicking a handle to include all
connections between the clicked connection and the previous connection. The connections will follow the shortest
route between the two points by following a chain of segments.
 
 

     
Some examples of figures containing polygon fill, with the polygon selected

 
 

Select a polygon by clicking it anywhere. The connected handles will be highlighted in red. The number of handle
connections and the draw order (z-order) will be shown in the status bar at the bottom of the window.

  Delete a polygon by selecting it and clicking the delete button. A polygon will also be deleted if a segment it
attaches to is deleted which results in the polygon having fewer than 3 handle connections.

  Setting the colour and changing the draw order (z-order) also works for polygons in the same way
as segments. Polygons can be semi transparent by setting the opacity in the colour selector.

 
 

Polygons and Bent Line Segments
Line segments can be bent into arcs by dragging the handle at the end of the line using the right mouse button. If
an edge of a polygon coincides with a bent line segment, then the polygon will fill the area inside the arc. This is



 

 

demonstrated by the cloud example shown above where all segments have been bent and the whole area filled with
a polygon. Note that the beginning and end of the bent line must both be connections of the polygon for this to work.
 
Operations on Branches Containing Polygons
A branch of a figure can be selected by holding down the Shift key. If the connections of a polygon are contained
entirely within the selected branch then it is also selected. This means that operations on the branch such as setting
the colour, deleting or changing the draw order (z-order) will also be performed on the polygon. However, if at least
one of the polygon connections is not part of the branch then this will not be the case.
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2.3.3. Segment Gradients
 
A linear gradient can be applied to line and circle segments by clicking a handle to select a segment and then
clicking 'Segment Gradient' in the Edit menu or by holding the Ctrl key while clicking the colour button. The colour
selector window will then allow you to select the gradient colour. The segment will then fade smoothly from the
segment colour at the segment's pivot point to the gradient colour at the segment's end point. Gradient colours can
be transparent or semi transparent.

The Segment Gradient menu item will have a check mark next to it if the selected segment has a gradient. Clicking
it again with a gradient segment selected will remove the gradient. Setting the segment and gradient colours to be
equal will also remove the gradient. The shift key can be used to apply or remove gradients for multiple segments
in a branch.

The horse figure shaded using segment gradients and the Segment Gradient menu item
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2.3.4. Figure Outlines
 
Figure types can be given outlines with a given thickness and colour. Click Outline Thickness Up in the figure builder
to increase the thickness by 1 screen pixel. Finer adjustment can be made by first zooming in. The thickness can
be increased of decreased more easily by using the keyboard shortcuts Ctrl+W and Ctrl+Q respectively.

Set the outline colour by clicking Outline Colour in the Edit menu (this will be disabled if the thickness is zero). The
outline can be made semi transparent by reducing the opacity in the colour selector.
 
 

   

  
Some examples of figure outlines

 

Outlines are drawn around all types of segment apart from sprite images. They are also drawn around polygons.
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2.3.5. Adding Sprite Images
 
Sprite images can be loaded into the figure builder and added to the figure type by clicking 'Load Sprite Image'
in the File menu. This makes it possible to create realistic looking figures built from multiple sprite images. After
loading a sprite you will be given the option of moving the handles so that the sprite pivots at the right point. Once
the handles have been moved click the OK button and select a handle to connect the sprite.

The transparency of sprites in the figure builder is the same as described on the sprite page. PNG transparency is
supported, otherwise all parts of the image that share the colour of the bottom left pixel will be transparent.

Repositioning Handles
After loading a sprite image it will be shown in a separate window and with a chequered background to show areas
of transparency. The handles can then be repositioned by dragging the orange and red handles. The orange handle
will be the pivot point of the sprite (where the center of rotation will be) and the red handle will be the end point (where
other segments or sprites will attach to. For example, if you're loading a sprite image to be used as the upper arm of
a person then you would move the orange origin handle to the shoulder and the red end point handle to the elbow.

The selected handle will be highlighted with a black dot at the center. The selected handle can be moved in 1 pixel
increments using the arrow keys. Note that the handles cannot be placed directly on top of each other.

Repositioning the handles of a body part sprite

Creating a Realistic Movable Figure from a photo
An image of a person, animal or object can be converted into a realistic moveable pivoting figure. First cut out each
moveable part using graphics software. Gimp is a free graphics application that can do this but is quite complex
to use. Microsoft Paint can be used but does not support transparency, so the result may not be as good. Another
option is a free and easy to use online photo editing software such as piZap or PIXLR.

https://www.gimp.org/
https://www.pizap.com/
https://pixlr.com/


 

 

Using the piZap cut-out tool to create body part images with transparent backgrounds

  The next step is to load each image part into the figure builder by clicking 'Load Sprite Image' in the File menu.
The handles should be repositioned so that each part pivots at the right points. After clicking OK select a handle
to attach the new part at the right point.

  If some parts of the figure are the same as others, such as arms and legs, then those sprite images only
need to be loaded once and can then be duplicated using the duplicate button. This reduces the number of
images that need to be stored. Holding the Shift key will allow you to duplicate a whole branch at once (such as
upper leg, lower leg and foot).

  If some parts are mirror images of other parts, such as a person facing front with mirrored arms and legs,
then the Flip / Mirror button can be used. Duplicate a body part while holding the Ctrl key to produce a mirrored
copy without the need to use the flip button.

  After adding all the parts, you can begin setting the draw order (z-order) so that the parts are in-front or
behind other parts as required. Simply select a part and use the Raise and Lower buttons.
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2.3.6. Modifying Existing Figure Types
 
If a figure type has been created and used in the animation but needs to be modified in some way then this is
possible by clicking the edit button, making the changes in the figure builder window and then clicking Modify Figure
Type from the File menu. The pose of the figures in each frame will be kept where possible. This is particularly
useful for adding new details to figure types after an animation has been created.
 

  Begin editing a figure type by selecting the figure and clicking the edit button in the main animation window.

Make changes to the figure type such as changing colours, changing the draw order of segments or adding or
deleting segments or polygons. Try to make the minimum changes possible and avoid deleting and re-adding
segments.

  Click 'Modify Figure Type' in the File menu to apply the changes to all figures of that type in all frames. This
operation cannot be undone, so a warning will be shown if the animation is unsaved. Make sure that you are happy
with the modification changes before saving again.

Note that changes to the pose of dynamic segments will not take effect on the resulting figures in the animation to
avoid overwriting their pose. However, changes to the angle of static segments will take effect.

If the default figure type is being edited then a new figure type will be created and all default figures in all frames
will be changed to the new figure type (you will be asked to name the new figure type).

Example of modifying a stickman figure type by adding a new line segment (a baton)
The timeline before (top) and after (bottom) shows that the changes have been applied to all frames

Note that the new baton segment automatically changes angle to follow the forearm segment

  Using the nominate origin button while editing a figure will result in frame figure poses being lost when Modify
Figure Type is used. All figures of that type will have their pose reset to that of the figure type. It is therefore not
recommended to use the nominate origin button while modifying a figure unless you don't mind the pose being
reset. This is also the case if all segments are deleted and replaced.

     Text objects can also be modified in a similar way. The 'Modify Existing Text Object' option can be found
by clicking the menu button at the top right hand corner of the text editor window.
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2.3.7. STK Files
 

 STK (Stick figure) files are the native Pivot file format for figure types. They can be stored on your computer
to be used in animations or shared with others over the internet.

     An STK file can be created by clicking Save As in the File menu of the figure builder. After making changes
to an STK file in the figure builder, the file can be overwritten by clicking 'Save' in the File menu or by using the
keyboard shortcut Ctrl+S.

     An STK file can be opened directly into the animation canvas area in the main Pivot window by clicking 'Load
Figure Type' in the File menu or by using the keyboard shortcut Ctrl+F. They can also be dragged to the canvas
area from Windows Explorer.

     Text objects can also be saved as an STK file or loaded from one. Click the menu button at the top right
of the text designer window to see the save and load options.

Compatibility Between Pivot Versions

STK files are always backwards compatible, meaning that files created with all previous versions of Pivot can be
opened in newer versions. However, the reverse is not always true. A file created in a particular version cannot be
opened in a previous version if the first digit of the version number is different. For example, a STK file created in
version 5.x.x cannot be opened in version 4.x.x (an error message will be shown). However, it is possible to save
in the format of Pivot v2 or v4 from the figure builder. This is done by clicking Save As and selecting a version from
the 'Save as type' dropdown list. However, it should be noted that any unsupported features may be lost.

STK File Preview

STK files can be previewed when opening in the figure builder or main window by clicking the 'show preview pane'
button at the top right of the Open file window. The version of Pivot that the file was created in is shown at the
top left of the preview.

STK files can also be previewed in Windows Explorer by clicking the 'Preview Pane' button in the View tab or using
the Alt+P keyboard shortcut.



 

 

Open STK file window, showing the preview.
The button to enable/disable the preview pane is highlighted top right.

 
 

STK Library
 
The STK Library is an online repository containing hundreds of figures to download for free. The library can be
quickly opened in your default web browser by clicking 'Download Figures' in the Help menu of Pivot Animator.
The library can be filtered based on category or Pivot version using the options at the top of the page. The library
contains both STK files and PIV files containing packs with multiple related figures. To use a figure from a PIV file
simply open it in Pivot, select the figure or figures you want to use and copy them (Ctrl+C). You can then open your
animation and paste the figures (Ctrl+V).

If you would like to contribute to the library then you can do so by sending the file as an attachment to
support@pivotanimator.net, but please only send your own work. Include your creator name and optionally a link to
your YouTube channel. The picture and file information will be generated from the file automatically and the name
will be taken from the file name. The library will be updated about once a week.

https://pivotanimator.net/stk-library/
https://pivotanimator.net/stk-library/


 

 

The STK Library web page, filtered by the People category and showing figure details
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2.3.8. Window Transparency
 
The figure builder window can be made transparent or semi-transparent. This is often useful when building new
figures that need to integrate with figures already in the editing canvas. For example, it's useful when creating multi-
figure backgrounds.

It can also be used to create accurate figures by tracing over images opened in an image viewer or web browser.
Segment colours can be matched while tracing by using the colour picker tool in the colour selector window  .
 

  The < and > keyboard keys can be used to adjust the level of window transparency. Ctrl+T can be
used to quickly turn transparency on or off.
 

Figure builder transparency. Designing a tree figure by tracing over an image found online
 

Window Controls
Note that the title bar of the window will disappear when transparent, but the window can still be moved by dragging
the area to the right of the menu. The window can be resized by dragging the bottom right hand corner of the
window to the right of the zoom percentage. It can also be maximised or restored by double clicking the area to
the right of the menu.

Match Canvas Pan/Zoom
When building complex objects, it is often useful to build larger objects from several smaller ones and then join
them on the main canvas using the Join tool. This allows parts of objects to be separated if needed and the draw



 

 

order (z-order) to be changed relative to each other. The Match Canvas Pan/Zoom option in the View menu makes
it easier to align new figure parts with objects already in the main canvas when the window is in transparent mode.
When selected, the pan and zoom changes made in the figure builder window while working on a figure will be
matched in the main window canvas. The two canvases will stay aligned even when moving or resizing the whole
figure builder window. If you'd like to change the alignment of objects then simply move the figure in the figure
builder window by dragging the orange origin handle.

The canvas matching option can be disabled by clicking the option again or by using the F8 keyboard shortcut.

Note that the canvases may not stay aligned when zoomed out a long way. This happens because the canvases
reach the limit that they can pan to. Rest assured that the alignment will return to exactly its previous state as soon
as you zoom back it.

The main canvas pan and zoom will return to its previous state when the canvas matching option is disabled, the
window transparency is disabled, the figure builder window is closed or if the figure builder window is moved such
that the canvases no longer overlap.
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2.3.9. Keyboard Shortcuts
 
Keyboard shortcuts can be used to speed up the process of building a figure. The shortcut for a button can be
viewed while using Pivot by hovering the mouse cursor over it, but are also given below.
 

  C - add a Circle

  L - add a Line

 P -  add Polygon

  D - Duplicate selected segment (+Shift for the whole branch, +Ctrl for mirror)

  K - change the Kind of the selected segment (line/circle)

  F - change the Fill of the selected circle

 E -  change the End cap of the selected line

  Up/Down arrows - change segment thickness by +/-1 pixel (+Shift for the whole branch, +Ctrl for +/-5)

  S - make the selected segment Static/dynamic (+Shift for the whole branch)

  O - set Origin joint of the figure at selected segment

  Insert - split selected segment by Inserting a joint (+Shift for the whole branch)

   Delete - Delete selected segment or polygon (+Shift for the whole branch)

 H -  set colour (Hue) of selected segment or polygon (+Shift for the whole branch, +Ctrl for gradient colour)

 M -  flip (Mirror) the selected segment (+Shift for the whole branch, +Ctrl for flip vertical)

 Right arrow -  raise selected object in draw order to top (+Shift for the whole branch, +Ctrl for 1 step)

 Left arrow -  lower selected object in draw order to bottom (+Shift for the whole branch, +Ctrl for 1 step)
 
 

 keys - Adjust window transparency
 
 
Shortcuts can also be used with the Ctrl key to perform operations from the menu such as Undo / Redo or Save
the figure type. These are shown to the right of their menu items.
 

  Ctrl+Z - undo
  Ctrl+Y - redo

      Ctrl+T - toggle window Transparency
      Ctrl+E - toggle Edit Mode

  Ctrl+S - Save figure
  Ctrl+Alt+S -  Save As

 
  Ctrl+N -  New figure
  Ctrl+O -  Open figure
  Ctrl+A -  Add figure to animation
  Ctrl+I - load sprite Image



 

 

      Ctrl+T -  make window Transparent / opaque
      <> or ,. -  decrease / increase window transparency
      Ctrl+W -  increase outline thickness (Width)
      Ctrl+Q -  decrease outline thickness
 
 
Shortcuts for zooming are the same as in the main animation window, although F3 and F4 zoom to the selected
segment or the whole figure respectively.
 

  + or Mouse Wheel Up -  zoom in
  - or Mouse Wheel Down -  zoom out
  F1 -  scale to 100%
  F2 -  scale to 200%
  F3 -  scale to selected segment or polygon and center (+Shift for whole branch)
  F4 -  scale to whole figure and center
  F5 -  scale to 50%

F8 - Match main Canvas Pan/Zoom with the figure builder pan/zoom when in transparent window mode
 
F12 - Highlight Selected Segment
I - Input segment values
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2.4. Onion Skins
 
Onion skins show you the position of the figures in previous or subsequent key frames when editing a key frame.
They are only shown in the frame editor canvas and not when playing or exporting an animation. By being able to
see the relative position of figures in neighbouring frames it makes it easy to judge the amount of movement that
should be applied to a figure to create realistic and fluid movements. In traditional hand drawn animation, this is
often done using tracing paper (originally made from actual onion skins) or light boxes.
 
Background Onion Skin
The background onion skin is similar to the onion skins in Pivot v2, except that they are in colour and semi-
transparent. They show all the figures from the previous frame only and are displayed behind all the figures in the
frame editing area, but in-front of the background image. This is so that they don't have to be redrawn every time
a figure is moved and so makes moving figures faster.
 
Selected Figure Onion Skins
The selected figure onion skins show onion skins from multiple previous key frames for the selected figure only. If
multiple figures are selected then they are not shown. These onion skins are shown just behind the selected figure
and so can normally be seen even when the editing area is filled with figures. They are shown in colour and are semi-
transparent with the amount of transparency increasing the further away that frame is from the frame being edited.
 

A selected figure and its onion skins showing its position in 4 previous frames
Onion skins are not shown when the animation is played or exported

 
The number of selected figure onion skins can be changed from 0-9 in the options window. There is also a check-
box that enables showing onion skins of subsequent frames when editing a frame in the middle of an animation
(Show Ahead). Displaying this kind of onion skin can slow down the movement of figures in the frame editing
canvas, so if it becomes to slow try setting the number of onion skins to zero. The number of onion skins is set
to zero by default for this reason.

The selected figure onion skins work by giving each figure an ID number that associates it with the same figure
in other frames. When you add a new figure to the editing area or duplicate a figure, the new figures will be given
a new unique ID. When you add frames to the time-line, the figures keep their ID's so that the same figure has
the same ID across all the frames that it appears in. This means that if you delete and then add a figure then you
won't see these onion skins for it since it will then have a new ID. The ID for the selected figure can be seen in
the status bar below the canvas.

After loading a Pivot v2 or v3 animation, you won't see these onion skins until you start adding new frames, because
figures will have a unique ID in all frames. This is because Pivot v2 and v3 didn't support this kind of onion skin
and so the PIV file doesn't store the figure IDs.
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2.5. Frame Inbetweening
What is Inbetweening?
In order for an animation to appear smooth it must be played at at least 10 frames per second (higher frame rates
appear even smoother). Creating each frame manually can therefore be a time consuming process. In the days
of traditional hand drawn animation, skilled animators would draw every 4th frame (called key frames) and less
skilled animators, called inbetweeners, would then fill in the missing inbetween frames to create smooth movement.
The process became known as inbetweening or just tweening. Now in the era of computers that process can be
performed automatically.
 
 

        
An example of Inbetweening. The 3 key frames are created by the animator (shown with an outline)
and the inbetween frames are created automatically by the computer when playing the animation.

The final animated sequence is shown on the right.
 
 
In Pivot Animator you can create key frames in the timeline and then select how many inbetween frames to create
between each pair of frames. This means less time to create your animation and results in smoother movement.
Everything about a frame will be inbetweened where possible, from the pose and colour of each figure to the position
of the virtual camera. It also enables the smooth fading transition of backgrounds.
 
See the Wikipedia page on Inbetweening
 
 

The process of Inbetweening in the 1930s
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2.5.1. Creating a Basic Inbetweening Sequence
 
In order to create a sequence with automatically generated inbetween frames, begin by creating at least 2 key
frames in the normal way by positioning and colouring the figures, setting the background and clicking the Add
Frame button to add them to the timeline. Then simply set the Inbetweens value for each frame. The inbetweens
value is shown to the left of the timeline in the animation frame controls. The value entered in the Inbetweens
edit box determines how many frames should be automatically created between the selected key frame and the
following key frame when the animation is played or exported. Any differences between the selected frame and the
next will vary smoothly while playing, including figure poses, colours, virtual camera position and the background.
The inbetweens value for a key frames is also represented as a green bar between that key frame and the next in
the timeline, which can also be dragged as a slider to change the value. The green bar ranges from 0 to 80, but
larger values can be entered in the inbetweens edit box if needed.
 

The timeline for a basic inbetweening sequence of a ball moving up and then down with key frame 2 selected.
The green bars indicate that inbetweens have been set. The inbetweens value of frames 1 and 2 is 5.

 
The Inbetweens value can be set for multiple frames at once. Select multiple frames by using the Shift key while
clicking frames or by using the 'Multi Select' option in the right click menu. Then set the inbetweens number and
click 'Update Frame'. A message box will ask if you want to apply the change to all selected frames.

Creating Pauses (Frame Repeats)
The Inbetweens box replaces the Repeat box present in previous versions. To create a pause in the animation with
no change, simply create two identical frames (right click the frame and select Insert) and then set the inbetweens
value of the first frame to set the duration of the pause. This is done automatically when loading animations created
using previous versions that contain frame repeats.
 
 
Hiding Key Frames
The example shown above suffers from a problem when the animation is played in Loop mode. The animation ends
with the same ball position as the first frame, so when the animation loops back to the start the ball will appear on
the ground for 2 frames in a row making the ball appear to pause on the ground. One solution to this is to position
the ball in the last frame so that it's above the ground, however, we would have to estimate where the ball should
be and also reduce the inbetweens value by 1 for the previous frame. A simpler solution is to set the inbetweens
value for the last key frame to -1. An X will then appear on that key frame in the timeline to indicate that the frame
will not be shown during playing or exporting. The key frame is then only used as a reference for inbetweening (the
generated inbetween frames will not be affected).

The timeline of the same animation as above, with the last key frame hidden by setting its inbetweens value to -1.



 

 

This avoids the ball appearing on the ground for 2 frames and results in the animation shown on the previous page.
 
 
Inbetweening of Angles
Inbetweening of angles is a little different to inbetweening of a figure's position because angles wrap around. Given
the angles of a segment between key frames, the program has to decide to rotate the segment clockwise or anti-
clockwise. The direction is chosen based on the shortest path between relative angles of the segment. This means
that a segment cannot be rotated by more than 180° between key frames relative to the segment it pivots on.
Multiple key frames will need to be created in order to perform rotations of more than 180°.

Rotating a stickman anti-clockwise by 360° in increments of 120° using 4 key frames (shown with an outline).
Going directly from the 1st to the 3rd key frame would result in a 120° rotation clockwise.

Tip: Hold the Alt and Ctrl keys while dragging a red handle to quickly rotate a figure in this way.

Segment angles are considered relative to the segments they pivot on while inbetweening. Rotating only a
stickman's upper arm for example will not change the relative angle of the lower arm, even if the absolute angle of
the lower arm has changed (as shown in the status bar segment info). This means that the absolute angle of the
lower arm can change by more than 180° between a pair of inbetweened key frames - for example by rotating the
upper arm clockwise by 100° and then rotating the lower arm clockwise by 100°.
 
 
Inbetweening of Backgrounds
If backgrounds are different between inbetweened key frames then the inbetween frames will smoothly fade from
one background to the other. This is the case whether the background has been loaded as an image or has been
set to a solid colour or gradient by setting the background colour. To avoid fading when changing backgrounds,
simply don't inbetween between those key frames (set the inbetweens value of the last frame with the previous
background to 0). 
 

Fading from day to night by inbetweening between 2 key frames with different image backgrounds.
The colour of the stickman was also modified between key frames.

 
 
Understanding Figure IDs
In order to inbetween figures between key frames, Pivot must know which figure corresponds to a particular figure
in other key frames. Pivot does this by assigning an ID to each figure. Each figure in a key frame has a unique
ID that matches the ID of the same figure in other key frames. The ID is then used during inbetweening and also
for showing onion skins for the selected figure while editing. The ID for the selected figure is shown in the status
bar at the bottom of the main window. When a new key frame is added to the timeline, the figures keep their IDs.
However, if you delete a figure and then add a figure of the same type using the figure selector then it will be given
a new unique ID and so will be considered as a new figure that isn't present in other key frames.

The status bar at the bottom of the main window, with the selected figure ID highlighted



 

 

    If you'd like to add a figure into a key frame with the same ID as a figure in another key frame then this can
be done by copying the figure in the other key frame and pasting it into the one being edited. The ID of the pasted
figure will be the same as long as there isn't already a figure in the key frame with that ID.

If a figure with a given ID is present in a key frame but not in the next one, and an inbetween has been set, then
the figure will be present in the generated inbetween frames but won't be inbetweened and will suddenly disappear
when the next key frame is reached. If a figure with a given ID is not present in a key frame but is in the next one, then
it will not appear in the generated inbetween frames and will suddenly appear when the next key frame is reached.
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2.5.2. Auto-Easing
 
Easing is a method used to smooth out movements between key frames by making objects accelerate or decelerate
during inbetween frames rather than travelling at a constant speed in a straight line. Easing tends to make
movements appear more natural since objects in nature rarely move at a constant speed and almost never change
speed or direction instantaneously, as that would require infinite acceleration. A falling object for example will tend
to accelerate towards the ground (unless it's falling very fast through the air).

Pivot can perform easing automatically while playing or exporting so that objects don't suddenly change speed or
direction between key frames. This feature can be turned on or off by selecting or unselecting Auto-Easing in the
Options Window (Animation settings tab under Inbetweening Mode). This parameter is stored in .piv files along
with the other animation settings. Objects will change at a constant rate for inbetween frames when Auto-Easing
is disabled and so the transition between key frames may not be as smooth.

        

        
Comparison of inbetweening with Auto-Easing enabled (top) and disabled (bottom).

Note: The ball is able to suddenly change direction when it hits the ground with
auto-easing enabled because there is no inbetweening between the last and first frames.

 
 

Auto-Easing can only be applied when multiple pairs of frames are inbetweened in a row. If only a single pair of key
frames is inbetweened by setting the inbetweens value for a single key frame (with the neighbouring frames set to
0 or -1) then easing cannot be applied. This is because 3 key frame poses are needed for computing acceleration.
Auto-Easing is applied to the pose of figures, based on their position and segment angles, and the virtual camera
pose, but is not applied to figure colours or background fading.

Note that it is still possible to make objects move at a constant rate when Auto-Easing is enabled. Simply move the
objects by the same amount in the same direction between each pair of key frames and set the inbetweens value
of the key frames to the same value. In this way you can make some objects move with acceleration while others
move with constant speed by carefully choosing how the objects are positioned in the key frames.
 
Example
In the following example, key frames have been created in the timeline for a pendulum. The inbetweens values are
set to 8, 17, 8 and -1. An additional key frame in the center position could have been added between key frames
2 and 3 so that all inbetween values were set to 8, but instead that key frame can be removed by doubling the
previous inbetweens value (+1 for the missing key frame). The inbetweens value of the final key frame is set to -1
so that the pendulum doesn't pause for 2 frames as the animation repeats. The start and end of the animation was
chosen to be the pendulum's center pose because this is the only point in the motion where the acceleration is 0.
This enables the animation to repeat smoothly with realistic acceleration when auto-easing is enabled.



 

 

Timeline of the pendulum animation. The inbetweens values are set to 8, 17, 8 and -1.
The final animation is 36 frames long but requires only 4 key frames.

 
Auto-Easing enabled                                  Auto-Easing disabled 

 
Creating Sudden Changes when Auto-Easing is Enabled
In some cases easing may not be desirable. For example, when making a ball bounce on the ground in the middle
of a sequence, since this requires a sudden change in direction rather than a gradual deceleration and acceleration.
The solution is to split the sequence into separate groups of inbetweened key frames separated by a frame with
inbetweens value 0 or -1.

An example is shown below. The first pair of frames forms a group since the 2nd frame inbetweens value is -1. Auto-
easing cannot be used in this group because there are only 2 frames, so the motion of the ball will have constant
speed as it rolls along the surface. The next 3 frames form a group with easing as the ball falls. The horizontal
position of the ball is changed with equal increments so that its horizontal speed is constant. The vertical position is
changed with unequal increments so that the ball accelerates towards the ground (a falling object will fall a quarter
of the distance in half the time it takes to reach the ground). The next 3 frames form another group with the ball
going up and then back down. The ball is able to suddenly change direction as it hits the ground because the
inbetweened sequences are separated into groups. An inbetweens value of -1 has been used at the end of each
group to separate them and so that the position at the end of one group and the start of another can be set the
same without the ball pausing there for 2 frames.
 

Timeline of the bouncing ball animation. The inbetweens values are set to 14, -1, 5, 5, -1, 3, 3, 0
 

  
The resulting animation, with the ball following a natural parabolic trajectory as it falls,

suddenly changing direction as it hits the ground and then following another parabolic curve 
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2.5.3. Adding Inbetween Frames to the Timeline
 
Inbetween frames created by setting the inbetweens value are only visible when playing or exporting the animation
and are not visible in the timeline. This simplifies the timeline and uses less memory. However, you can expand an
inbetweened sequence so that its inbetween frames get added to the timeline. The original key frames will have
their inbetweens values set back to 0 so that the resulting animation will be the same when played.

This may be useful for a number of reasons such as having the ability to make changes to the inbetweened
sequences that would not be possible using inbetweening alone.

Add inbetweened frames to the timeline by selecting at least one key frame in the timeline that has a inbetweens
value set > 0 and clicking 'Add Selected Inbetweens to Timeline' in the Edit menu. This will only be enabled if
an inbetweened key frame has been selected. Note that this action cannot be undone, so it may be wise to save
first and check that the result is as expected before saving again.

The timeline before and after using 'Add Selected Inbetweens to Timeline'
All frames were first selected by using the Shift key. Auto-Easing is enabled.

 
 

Multi-Selecting frames with Auto-Easing
When adding frames to the timeline, the program only uses information from the selected frames. This means that
if you only select one inbetweened key frame then the resulting generated frames will not be eased even if the
frame is in a group of multiple inbetweened key frames and Auto-Easing is enabled.

For this reason It is important to select all key frames in a group of multiple consecutive inbetweened
frames before using the 'Add Inbetweened Frames to Timeline' feature if you want the resulting movements
to not change when auto-easing is enabled.

Select multiple frames by using the Shift key while clicking frames or by using the 'Multi Select' option in the right
click menu.
 
Inbetweening Between the Newly Generated Key Frames with a Background Fade
The newly generated frames can now be treated as key frames and new inbetweens can be created between them if
needed. However, with regards to background inbetweening, it should be noted that a frame cannot contain a blend
of more than two backgrounds. If a newly generated key frame already contains a fade between two backgrounds,
then you cannot fade between that key frame and a key frame containing a 3rd background in the expected way.
One of the background images will be lost.
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2.6. Multi-figure Selection
 
Operations can be performed on multiple figures in the frame editing area. This can save a lot of time if you want
to move multiple figures by the same amount or apply the same operation to them. Selected figures are displayed
with an orange origin handle and red segment handles. Unselected figures are displayed with blue handles.
 
Selecting and Deselecting
Selecting figures works in a similar way to selecting files in Windows Explorer, with the main difference being that
at least one figure must always be selected if figures exist. Normally when clicking a figure without dragging it,
that figure will become selected and all other figures will become unselected. However, there are several ways to
select multiple figures.
 

  Holding down the Shift key while clicking any figure will change that figure between being selected and
unselected, without effecting other figures.
 

Dragging a rectangle around multiple figures by holding the mouse down anywhere where there isn't a handle will
select any figure whose origin point is within the rectangle. This will not effect any figure outside the rectangle.
Similarly, figures can be unselected by firstly dragging a rectangle around them and then dragging so that they are
no longer inside the rectangle.

A group of joined figures can be selected by double clicking the figure at the base of the tree. This can be useful
if there are many other figures on the editing canvas.

Finally, all figures in the frame can be selected by clicking 'Select All Figures' in the Edit menu or by using the
keyboard shortcut Ctrl+A.
 
Moving Multiple Figures
Once multiple figures have been selected, they can be moved around as if they are a single object. Drag any orange
origin handle to move the selected figures or use the arrow keys to move them in 1 pixel increments.
 

  Hold down the Alt key on the keyboard and drag any red handle to rotate and scale the selected figures as if
they were a single object. The figures will rotate and scale around their common centre. As with single figures, the
Ctrl and Shift keys can be used in combination with the Alt key to lock scale and rotation respectively.
 

 + Z. The Alt and Z keys used together will lock the separation of the figures so that the position of their centres
remains constant.

 + X. The Alt and X keys used together will lock the scale of figures but allow their separation.
 



 

 

Multi-figure rotation and scaling using just the Alt key.
The green dot indicates the common centre of the selected figures and does not move.

 
Multiple Figure Operations
Most of the figure control buttons work with multiple selected figures.

    
The delete, colour and opacity controls work on each selected figure separately. All selected figures will be deleted
or set to the chosen colour.

    
The centre, flip and scale controls treat the selected figures as if they were a single object. The centre button centres
the common centre of the selected figures so that they stay in the same position relative to each other. Similarly, the
flip button flips the selected figures horizontally about their common centre. The value in the scale control shows
only the scale of the first figure that was selected, but when changed all selected figures will change such that their
scale's stay fixed relative to each other.

  
The raise and lower buttons send all selected figures behind or in-front of the unselected figures. They will stay in
order relative to each other. If Ctrl is held then each figure will be raised or lowered by 1 figure layer.

The duplicate button duplicates all figures. The resulting duplicates will have the same position relative to each
other and will then be selected. If selected figures are joined using the join tool, then the duplicates will also be
joined. If a selected figure is joined to an unselected figure, then its duplicate will be unjoined.

  
The edit and join buttons do not work with multiple selected figures. The join button will be disabled and the edit
button will open the figure builder, but only with the first figure that was selected.
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2.7. Joining Figures
 
Pivot Animator allows you to join figures together so that figures can be positioned as if they were a single figure.
The figure joining feature can be used for many different reasons, such as letting a stickman hold an object or
creating complex backgrounds that are easier to move as a single object.
 

         
Joining a stickman and horse figure so that they move together

The horse was first edited to add a new handle at the top of the back

Figures can be joined together recursively in chains or a tree structure, but not so that they form a loop. Multiple
figures can be joined to a single handle.

Figures are joined together in a tree structure in a similar way to the segments in a figure. If two unjoined figures
are joined, then the one that was selected and joined is above the other in the tree structure. The one it was joined
to is not joined but has a figure joined to it and is therefore at the base of the tree.

Joining and Unjoining

The join button can be found in the figure controls and is enabled only when a single figure is selected. If the figure
is not currently joined then the button will display a white handle. To join the figure to another, click the button and
all the handles that the figure is allowed to join to will turn white (static segments will also be shown). Click any of
the white handles to join the figure such that its origin point joins to the clicked handle. The figure will then move to
its joined position and the handle at the join will be white to indicate that it is joined.

To unjoin a figure, firstly select a joined figure. The join / unjoin button will then show a red and orange pair of
handles. Click the button and the figures will no longer be joined and can then be moved independently.
 
Positioning Joined figures
Once joined, the segments of joined figures will move as if they were a single figure when rotated. A figure joined
to a rotated segment will therefore also rotate and move such that its origin is positioned at the point it's joined to.
 

  When using the Alt key to rotate and scale a figure, all figures joined to that figure, that are above it in the
tree structure, will also rotate and scale. However, the opposite is not true - if a joined figure is rotated and scaled
using the Alt key, then the figure it is joined to, which is below it in the tree, will not be scaled or rotated. If you want



 

 

to scale and rotate a whole connected group of figures, then make sure you drag a red handle in the figure at the
base of the tree structure that all other figures attach to.
 

  The scale control in the figure controls will scale only the selected figure or figures and not any figures
joined to it.

Moving the Figure Origin
A join can only be made between the orange origin handle of the figure being joined and a segment or origin handle
of another figure.

  If you wish to join figures at two red segment handles then you must create a new figure type by editing one
of the figures in the figure builder and using the origin tool to move the origin point to a different handle.
 
Selecting Joined Figures
Joined figures can be selected in the normal way as described on the Multi-Figure Selection section. However,
you can also double click a figure and all figures joined to it will become selected. Double click the figure at the
base of the tree to select the whole group of joined figures. This can be useful if there are many other figures on
the editing canvas.
 
Combining Joined Figures into a Single Figure
Joined figures can be combined into a single figure by clicking 'Edit Joined Figures' in the Edit menu after selecting
at least one of the joined figures. All figures in that joined group will appear in the Figure Builder in their current
pose, from where they can be added to the animation or saved as a single STK file. This is useful for converting
multi-coloured figures made in Pivot v4 into a single easily sharable STK file.
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2.8. Backgrounds
 
Backgrounds are images, solid colours or gradients that can be set as the background of a frame. Different frames
can contain a different background, which means that you can create different scenes and settings within a single
animation. A background image can be created in MS Paint or other graphics software or downloaded from the
internet.
 
Image Backgrounds

  A background image can be loaded into the animation by clicking 'Load background' in the File menu.
Supported image file formats are Bitmap, JPEG, GIF and PNG. The image resolution will be maintained and will
be fitted to the animation dimensions. If the aspect ratio of the image differs to the aspect ratio of the animation,
then part of the image will be outside the animation to the right or bottom and will be shown faded out while editing
the frame. This makes it possible to use images that are a higher resolution than the animation so that zooming in
using the virtual camera results in less pixelation of the background.
 
Solid Colour Backgrounds
A background with a solid colour can be set by clicking 'Set Background Colour' in the File menu. Make sure
that 'Solid Colour' is selected in the Background Colour window, select a colour and click Add. You will be asked to
name the new background unless an identical background already exists. The default background is a solid white
colour. Using solid colours or gradients is quicker than creating and loading an image and uses much less memory
in the .piv file. Note that colours can have opacity, which makes it possible to export the animation to formats that
support transparency.
 
Linear Gradient Backgrounds
A linear gradient is a fade between two colours in a given direction. The sky on a clear day is often a linear gradient
between two shades of blue. A background with a linear gradient can be set in a similar way to a solid colour by
selecting 'Linear Gradient' in the Background Colour window. Select the two colours of the gradient and position
the two gradient control points in the rectangle to the right by dragging them. Note that the control points can be
positioned outside of the rectangle area and even outside of the window if required. The only way to reposition them
after dragging outside of the window area is to unselect 'Linear Gradient' and then select it again, which will reset
the control points. Apart from using up much less memory than images, gradients appear much smoother when
zoomed in, either when using canvas zoom or the virtual camera.
 
Radial Gradient Backgrounds
A radial gradient is a fade between two colours starting from a central points and going outwards. This can be
useful for creating the effect of a glowing light source. Set a radial gradient by selecting 'Radial Gradient' in the
Background Colour window. One control point in the rectangle sets the center of the gradient and the other sets
the outer radius, outside of which there is no more fading (only the distance from the center point matters). The
inner radius controls where the fading starts relative to the center and is set using the 'Center Offset' slider, where
100% sets the inner radius and outer radius to be the same.



 

 

The background colour window set for a radial gradient
 
Background Selector
The background selector is similar to the figure selector and provides a way to set the background to one that has
already been loaded into the animation.

The background selector is displayed by clicking the 'Background' button in the main window when at least one
background has already been loaded.

The figure selector also allows you to search for a background by name. Simply click the search box and start
typing. Any background name containing the search term will be highlighted with bold text while all others will be
greyed out. The scroll of the window will also automatically shift to the first highlighted item.

The Rename button allows you to modify the name of existing backgrounds. Click the Rename button and then
click a background to rename. A naming window will then appear. Note that you cannot rename the default white
background (first item) and names must be unique, so a message will be shown and renaming will fail if another
background already contains the new name.

The background selector, showing the default white background,
two image backgrounds, a linear gradient and a radial gradient

 



 

 

 
Setting the Background for Multiple Key Frames
The background image can be set for multiple key frames by selecting key frames using the Shift key or Multi Select
option in the right click menu, setting the background and then storing the changes by clicking the 'Update Frame'
button or by selecting another frame in the time-line. Click 'Yes' when asked if you want to apply the changes to all
selected frames or 'No' to apply to only the last frame selected.
 
Inbetweening
If backgrounds are different between inbetweened key frames then the inbetween frames will smoothly fade from
one background to the other. This is the case whether the background has been loaded as an image or has been set
to a solid colour or gradient by setting the background colour. To avoid fading when changing backgrounds, simply
don't inbetween those key frames (set the inbetweens value of the last frame with the previous background to 0). 
 

Fading from day to night by inbetweening between 2 key frames with different image backgrounds.
 

Note that a frame cannot contain a blend of more than two backgrounds. If the 'Add Selected Inbetweens to Timeline'
feature has been used so that a key frame already contains a fade between two backgrounds, then you cannot fade
between that key frame and a key frame containing a 3rd background in the expected way. One of the background
images will be lost.
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2.9. Sprites
 
Sprites are images that can be moved around, scaled or rotated in the same way as a figure. A sprite is actually a
type of figure segment and so lines, circles or other sprites can be connected to it by editing it in the figure builder.
A sprite image can be created in a graphics application or downloaded from the web.

  A sprite can be loaded into the frame editing area by clicking 'Load Sprite Image' in the File menu. Image formats
that are supported are Bitmap, GIF and PNG.

Using large sprite images can cause lag when moving figures.

Transparency
Sprite images support transparency in PNG and GIF images. If transparency is found in the image then it will be
used. This makes it possible for parts of the image to be semi transparent and also can make the edges of the sprite
appear smoother. PNG images with transparency can be created in graphics software such as SketchPad or Gimp.
 

The glass is an example of a semi-transparent Sprite loaded from a PNG file
 
If a Bitmap image is loaded, or transparency is not found in a PNG or GIF image, then sprites are displayed with a
transparent background determined from the colour of the bottom-left pixel of the sprite image. If you don't want any
transparency then simply set the bottom left pixel to any colour that doesn't appear in the rest of the sprite image
or add a vertical or horizontal line of that colour to the left or bottom of the image.
 

                  
Left: How a Bitmap image looks in Paint. Right: How it looks in Pivot.

The problem: The bottom left pixel is black, so all black pixels are transparent and everything else is opaque.

https://sketchpad.io
https://www.gimp.org/


 

 

 

                 
Left: How a Bitmap image looks in Paint. Right: How it looks in Pivot.

The solution: A line has been added below the feet so that the bottom left pixel matches the background.
The background has been changed from white to green to avoid the eyes becoming transparent.

 
 
Joining Sprites
The figure builder makes it possible to join sprites together into a single figure, which can be saved as a single
STK file.

  It is also possible to join sprites together using the join feature in the main animation window to create realistic
stick-men or other objects that can be moved in the same way as a figure. Note that this method was common in
previous versions of Pivot but is more complex compared to creating multi-sprite figures in the figure builder and
the resulting figure cannot be saved as a single STK file. The method is demonstrated in the following video.
 

 
The first step for doing this is to create your sprite images and load them into the frame editing area.

The second step is to reposition the handles so that the sprite joints are at the right places.

      This can be done by clicking the edit button to open the sprite in the figure builder and adding
new lines to the locations of the new joints/handles. You can then set these lines to zero thickness and set all but
one to static so that only the two new handles are seen. Then use the origin tool to move the origin point to one
of the new handles.
 

http://youtu.be/a2SccBERXaE
http://youtu.be/a2SccBERXaE
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2.10. Text Objects
 

   Text objects can be added by clicking 'Create Text Object' in the File menu. The text editor window will then
appear. Add the required text in the edit box at the top. The preview will update after each new line (press enter) or
after clicking on one of the other controls. The font can be selected from the drop-down list or typed in. The colour
can be selected by clicking on the button below 'Fill Colour'. The text can also be given an outline by increasing
the Outline width and setting the outline colour. Colours can be semi-transparent by setting the opacity in the
colour selector. Italic and Bold styles can also be applied.

The outline option is useful for creating subtitles for your animation. Subtitles are normally white with a black outline
so that they are always visible regardless of the colour behind the text.

The gradient option can be used to create a vertical fade between the 'Fill Colour' at the bottom and 'Gradient
Colour' at the top. The outline is unaffected.

The multi-line alignment options determine how multiple lines of text align to each other and is only enabled if
multiple lines of text have been added into the edit box.

Click 'Add' to add the text object to the animation as a new figure type. Text objects behave like a figure type with a
single segment. As such they can be moved around, rotated, scaled or selected from the figure selector by clicking
the 'Add Figure' button. However, text object cannot be edited in the figure builder. Editing a text object by clicking
the edit button in the selected figure controls will open the text in the Text Editor.

  If you have rotated a text object and want to align it to be horizontal again then you can do this easily
by placing the mouse cursor over the red handle of the text object and pressing the right arrow key while holding
the Shift key, as described on the Positioning Figures page.

  Dragging the red handle while holding the Ctrl key will have the effect of stretching the text horizontally.
 
 

     



 

 

The text editor window (left) and after adding to the animation with rotation, scale and stretching (right)
 
 

Menu Controls
   The menu controls can be accessed by clicking the menu button at the top right of the Text Editor window.

   Open:   Load a text object from an STK file. If the STK file is not a text object then it will not open and a message
will be shown.

   Save As:   Save the current text object as an STK file.

   Modify Existing Text Object:   Modify the text object being edited in all frames. This is similar to Modifying
Existing Figure Types in the figure builder and is only enabled if the text editor was opened by clicking the edit button.

   Help:  Open this web page in the default browser.

 
Fonts
Text objects support True Type Fonts. The drop-down list of fonts will show the true type fonts that you have installed.
You can download and install other true type fonts from the internet. The list will then include the newly installed
fonts after restarting the application.

Pivot Classic will appear at the top of the list of fonts. This font has been created to replicate the alphabet character
figures included with earlier versions of Pivot, and makes it possible to have the classic Pivot text style without the
need to load and position each character figure manually. This font can also be used in other applications such
as Microsoft Word.

 
If you are editing an animation created on another computer with text objects using fonts that you don't have
installed, then everything will look fine in the animation, but if you try to edit the text object then a warning message
will show to tell you that a font is missing and the font will be reset to default.

Creating Non Alpha-Numeric Symbols
There are various ways to create non alpha-numeric symbols using the text editor. This is useful for quickly adding
certain objects that would take time to create using the figure builder or for adding text in languages that use non
Latin script. The first method is to use one of the symbol fonts such as Webdings. The symbol fonts are marked
with a * before the font name in the drop-down list. For example, typing the letter 'b' using Webdings will create
a bicycle and typing ')', ']', '}' or '(', '[', '{' will create speech bubbles, as shown below. For the speech bubbles, the
outline thickness and colours were set.

           

https://en.wikipedia.org/wiki/TrueType
https://en.wikipedia.org/wiki/Webdings


 

 

 
Alt codes can also be used under Windows by typing a number using the number pad while holding the Alt key.
You can't type them directly into the edit box in the text editor, but you can type them into a text editor program such
as Notepad and then copy and paste the result into the Pivot text editor window. The following card suites were
created with Alt+3, Alt+4, Alt+5, Alt+6 using the Candara font. The appearance can vary with font.

Finally, the text editor supports many Unicode characters, which includes thousands of symbols, including those
from non Latin scripts such as Japanese. The following was created by translating the word 'Pivot' into Japanese
using Google Translate and copying and pasting the result into the text editor (the symbol for 'Pivot' is the same
in Chinese). Normally the appearance will not vary with font.
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2.10.1. Speech Bubbles
 
As a Figure
Speech bubbles can be added in a few different ways. The easiest way is to use the speech_bubble.stk and
thought_bubble.stk figure types that are installed with Pivot Animator and can be found in the Figures folder. These
figures were made in the figure builder and so it is possible to edit them in a number of ways or even make new
ones. The figures are made by bending line segments using the right mouse button to create the outline and then
filling the center using the polygon tool.

Add one of the figures to the animation using 'Load Figure Type' from the File menu, then set the scale and use
the flip button if required, depending on which side of the stickman figure you want it to be positioned. Next, create
the text you want to put in the bubble using the Text Editor. After adding the text to the animation you need to set
the scale so that it fits within the bubble and then position it. The speech bubble figures have an extra handle that
you will see within the bubble area. Drag this handle while holding the Ctrl key to position it over the orange origin
handle of the text object. Now select the text object and join it to that bubble figure handle using the Join Tool. Now
they can be positioned as a single object. Note that if you add the text object before the speech bubble then you
will need to use the raise or lower buttons to change the draw order (z-order).
 

    
The speech and thought bubbles as seen during editing (left) and after exporting (right)

The font used for the text object is Segoe Print
 
 

As a Text Object
The previous page describes how to create non alpha numeric symbols using the Webdings font. Typing ')', ']', '}'
or '(', '[', '{' into the Text Editor will create speech bubbles, as shown below. The outline thickness and colours then
need to be set to create a black outline with a white center. They can then be added to the animation with another
text object to place inside the bubble.

Joining the two text objects is a little more difficult that using the bubble figures described above. A new figure
type will need to be created in the figure builder consisting of a single line segment with 0 thickness. This can then
be added to the animation and the angle and length set using the Ctrl key so that the line extends from the red
handle of the bubble object to the orange handle of the text object. Both objects can then be joined to the line so
that they move as one object.

One advantage of this method is that the Ctrl key can be used to stretch the speech bubble text object to change
it's shape depending on the text you want to put inside it.



 

 

Speech bubbles created using Webdings font with the characters ')', ']', '}' and '(', '[', '{'
 
 

As a Sprite Image
A speech bubble image can be created in graphics software or downloaded from the web as a gif or png image
and loaded into Pivot as a Sprite. The text could be added in Pivot as a text object or included in the original image.
However, using sprites is not the best option for a couple or reasons. Firstly, they would look pixelated when you
zoom in using canvas zoom or the virtual camera. Secondly, they will use up a lot more space in memory and in
the saved .piv file.
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2.11. Virtual Camera
 
The virtual camera makes it possible to easily create camera pan, zoom and rotation effects in your animation
without having to move all the figures. Instead you move a camera viewport, which when in its default position
is aligned with the boundary of the animation. What you see when you play or export the animation is the area
contained within the camera viewport, but transformed back to the animation area. Shrinking the camera viewport
will therefore creating a zoomed in effect, while moving it to the right will pan animation objects to the left. Use the
preview frame feature (Ctrl+P) to quickly see how the frame will look from the perspective of the camera.

Note that key frame thumbnails shown in the timeline are from the perspective of the camera so that they show
what you would see when playing the animation.

   
The camera viewport positioned in the frame editing canvas (left) and the result when the frame is previewed (right)

The grey onion skin of the camera viewport from the previous frame is visible in its default position (left)
 

Showing / Hiding the Camera Viewport
The camera viewport is not visible unless the 'Show Virtual Camera' option is selected in the View menu. This
option is stored so that it is persists after closing and re-opening Pivot Animator. The keyboard shortcut Ctrl+K can
be used to quickly toggle the option on or off.

The camera viewport will always be shown when editing a key frame in which the camera is not in its default
position, even if 'Show Virtual Camera' is unselected, although the viewport will be faded out and you won't be
able to position it.

Positioning the Camera Viewport
The camera viewport can be moved, scaled or rotated by dragging the square handles at the corners of the
rectangle. The center of the viewport is shown with a red cross. Note that rotation and scaling of the viewport is
always around the center. The aspect ratio of the viewport always matches that of the animation.



 

 

Moving, rotating and scaling of the camera viewport by dragging the square handles.
Either of the indicated handles can be used for scaling (right).

The camera viewport can be restored to its default position (aligned with the animation area) by clicking 'Reset
Virtual Camera' in the View menu or by using the keyboard shortcut Ctrl+Alt+K.

The camera viewport can also be copied by selecting 'Copy Virtual Camera' from the View menu or by using the
keyboard shortcut F11. The viewport can then be copied to another frame or another animation by selecting 'Paste
Virtual Camera' from the View menu or by using F12.

The current pose of the camera is shown in the status bar at the bottom of the main window when 'Show Virtual
Camera' is selected.

  The camera viewport can also be positioned accurately by using the arrow keys, while the mouse
cursor is positioned over a handle, to move that handle in 1 pixel increments. The cursor won't move with the
handle, but the arrow keys will continue to move that handle until the cursor is moved. Even finer positioning using
the arrow keys can be achieved by first zooming in. For example, zooming to 400% and pressing an arrow key
while the cursor is over the orange handle is equivalent to moving the viewport by a quarter pixel.

  The camera viewport can be aligned to match its pose in the previous frame using the L key (or L+Shift to
align to the next frame) while the cursor is positioned over one of the camera handles. Using the L key over the
orange handle will align the center of the viewport without changing rotation or scale. Likewise, using the L key over
the rotation or scale handles will change only rotation or scale without affecting anything else.

  The camera viewport can also be set to any set of position values using 'Input Camera Values' in the Edit
menu, which will appear after clicking a camera handle. You can also use the 'I' key while the cursor is over a
camera handle. This works similar to the input for figure positioning and allows you to set the angle, scale and
position to specific values. When scale is 1, the camera viewport matches the animation dimensions. The position
is relative to the center of the camera viewport.

Any movement of the camera viewport can be undone in the usual way by clicking 'Undo Move Camera' in the
Edit menu or using the keyboard shortcut Ctrl+Z.

Positioning in Multiple Frames
The camera viewport pose can be updated in multiple frames at once. Firstly select the frames in the timeline and
then move, rotate or scale the camera by dragging the handles. A message box will appear asking if you want
to apply the change to all selected frames. The changes are applied relative to the current camera pose in each
frame, so they will be offset by the same amount that the camera was offset in the frame being edited. This means
that if the camera poses are all different in the selected frames, then they will remain all different after the update,
but will all be offset from their previous poses.

Camera Inbetweening
The camera can be inbetweened in the same way as figures to easily create smooth pan or zoom effects with
two or more key frames. Auto-easing can also be used for smoother transitions between key frames and to create
acceleration effects.

Note that when inbetweening between different camera scales the objects in the camera view can appear to speed
up or slow down. This is because a change in scale has a bigger effect when the camera viewport is smaller
compared to when it is larger. However, auto-easing can be used to prevent this effect. For example, when zooming
in from a scale of 1 to 0.25 you can use 3 key frames instead of 2 and set the scale to 0.5 for the middle key frame.
The scale will then change by a constant multiple (0.5) between key frames so that objects in the camera view



 

 

increase size at a constant rate. If changing the camera position at the same time, then the position must also be
set with non equal offsets.

              
Creating a pan and zoom sequence using 2 key frames (left) and 3 key frames with auto-easing (right)

The camera scales on the left are 1 and 0.25. The scales on the right are 1, 0.5 and 0.25
The inbetweens values are 14, -1 on the left and 7, 7, -1 on the right

                       
The resulting looping animations showing the acceleration effect with 2 key frames (left)

and constant speed with 3 key frames (right)

Including Areas Outside the Animation
It's possible to position the camera viewport however you like, even to include areas that are outside the animation
area. For example, moving or rotating the viewport from its default position will include areas outside the animation
area (apart from a rotation of 180°). How these areas look when the animation is played or exported will depend
on the type of background used.

Solid backgrounds, such as the default white background, will fill areas outside the animation area with the same
solid colour.

Gradient backgrounds will extend the gradient to fill areas outside the animation area.

Image backgrounds will fill areas outside the image with solid black. If the aspect ratio of the image is not equal
to the aspect ratio of the animation then some portion of the image will be visible to the right or bottom of the
animation area.

Note that when inbetweening the camera viewport there may be cases in which the viewport is fully inside the
animation area in all key frames but contains areas outside the animation in the generated inbetween frames.
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2.12. Options
 

  The options window can be accessed by clicking 'Options' in the Edit menu. Any options modified in the options
window will be stored so that the values persist after closing and reopening the program.

Any values changed will take effect after clicking the 'OK' button. Clicking 'Cancel' will close the window without
changing any settings and the changes will be lost.

Click the 'Restore Defaults' button to set all values to the default settings that Pivot had when it was first run.
 
 

Animation Settings
The Animation Settings tab contains options specific to the current animation. These parameters affect how the
animation looks while playing or exporting. The values are stored in the .piv file when the animation is saved.

 
Dimensions
Set the Width and Height to set the dimensions of the animation. The resulting animation area is indicated by the
dotted rectangle in the frame editing canvas.

If you have already added frames to the time-line then you will be prompted to confirm the changes after clicking
'OK'. All frames in the time-line will then change to the new dimensions.

If you intend to export the animation as a video, then it is advisable to set the width and height to multiples of 4
to avoid black borders in the resulting video.

The default is 640x360, which corresponds to the commonly used 16:9 widescreen aspect ratio. Note that it is
possible to scale the animation when exporting, so you do not need to set HD dimensions to produce HD animations.
 
Play Speed
The Play Speed is equivalent to changing the track bar in the player controls, except that the value can be
typed in manually. A larger number results in a faster playback speed. The animation below the Play Speed box
demonstrates the resulting animation speed.
 
Inbetweening Mode



 

 

Enable or disable Auto-Easing so that object movement is smooth between key frames (using acceleration), or is
always a constant speed. The animation to the right of the Inbetweening Mode box demonstrates the motion of
objects between key frames (large grey circles) with the current Auto-Easing selection.
 
 
Preferences
The Preferences tab contains general options related to the editing interface, which do not affect how an animation
looks while playing or exporting.
 

 
Onion Skins
Set the number of selected figure onion skins from 0 to 9. The default value is zero since this reduces lag when
moving figures in the frame editing area.

Select 'Show Ahead' to show onion skins ahead of the frame being edited when editing a frame in the middle of
the animation time-line.

Figure Handles
Handles are the red or orange nodes used to position the figures.

Show Unselected
Unselect 'Show Unselected' to show only the origin handle of unselected figures. This helps to reduce handle clutter
in the frame editing area so that selecting and moving figures is easier. When selected, all handles will be shown
as blue in unselected figures.

This setting does not apply to joined figures because there would then be no way to select a joined figure. Therefore
all handles are shown for unselected joined figures even when the option is unselected.

This option can also be changed more quickly from the main animation window by using the Ctrl+H keyboard
shortcut.

Autosize
Choose how the size of handles is determined. When selected, handle sizes will be based on the length of their
attaching lines. This means that neighbouring handles that are close together due to short segments will be small
to prevent overlap, which can make dragging handles easier.



 

 

When unselected, handle sizes are large and may overlap when close together. Handles will only reduce in size
if the lines they're attached to are both short and thin. This option can be used if you find it difficult to drag small
handles.

Black Outline
Choose to show handles with a black outline or not. A black outline means that the handle can always be seen even
against red or orange backgrounds, but no outline may look clearer. This does not affect the size of the handles.

Language
Select the language for Pivot captions and messages.
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2.13. Exporting an Animation
 

Animations can be exported in a number of formats. These include animated GIF image and animated PNG files
for web pages, several video formats for adding sound or other effects in video editing software or uploading to
YouTube, and as separate images in a number of image formats.

  Export an animation by clicking 'Export Animation' in the File menu and then selecting a format from the sub
menu.

Exporting an animation can take several minutes depending on the length of the animation, format and options
chosen. A progress bar will be displayed while exporting. You can stop the export process at any time by closing
the progress window.
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2.13.1. Animated GIF
 
Animated Gif images are often used on web pages and are widely supported on all web browsers. They have a
relatively small file size compared to video formats and can be easily embedded into web pages, but may result
in poorer quality since they support a maximum of only 256 different colours. This restriction can be partially
overcome by selecting the dithering option, described below. Animated gifs also support transparency, but not semi-
transparency.

Click 'Export Animation' in the File menu and select Animated Gif from the submenu. Then specify a file name
and location and click 'Save' to display the animated Gif options. After setting the options, click 'Export' and wait
for the progress bar to reach the end.

Make sure that the speed of your animation is correct when playing before Exporting the animation because the
same frame rate will be used when exporting the Gif. This can be adjusted using the scroll bar next to the Play
and Stop buttons.
 

Animated Gif export options
 
Height
The Height option allows you to specify the dimensions of the exported gif. The default value matches the height
of the animation set in Options. The width is determined automatically from the animation aspect ratio. Note that
a larger value will increase the file size.

Loop
Select the Loop option so that the exported animation loops back to the beginning when it reaches the end. This
is recommended if the animation is to be used on web pages. If not selected then the animation will play once and
then stop on the last frame.
 
Dither
The Dither option can be used to improve the appearance of the animation when the animation contains a large
number of colours and particularly when the animation contains gradients of gradually changing colours. Dithering
is therefore often required when backgrounds or sprite images are used that are derived from photos or if a gradient
background has been set. The option will be selected by default if the animation contains an image, gradient
background or figures containing sprites. Note that although dithering often improves the quality of the gif it will
also increase the file size.

 

http://en.wikipedia.org/wiki/Animated_gif#Animated_GIF
http://en.wikipedia.org/wiki/Dither#Digital_photography_and_image_processing


 

 

     
Without dither (98KB)                                    With dither (224KB)

 
Smooth Edges
When enabled, the figures will have smooth anti-aliased edges as they do when editing. When disabled, the figures
will have jagged aliased edges, which is equivalent to exporting in Pivot 4 with Super Sample set to 1. Most of the
time you will want Smooth Edges enabled as it is by default. However, disabling may be useful if you want a more
retro look, want to reduce file size or because you want to fill areas after exporting.

 
 
Transparency
Animated gifs can be exported with transparent regions so that they can be overlaid onto other components of web
pages while allowing the areas behind to be seen. Firstly set the background of the animation to solid transparent
using the background colour editor. Set the opacity to 0 when selecting the colour. Now when you export the
animation to animated gif the visible areas of background will be transparent.

Note that animated gif does not support semi transparency, so areas of the gif will be either fully transparent or fully
opaque even if semi transparent backgrounds or figures have been used. For animations with semi transparency
try exporting to the animated png format.

Created with Dr.Explain
Unregistered version

https://en.wikipedia.org/wiki/Spatial_anti-aliasing
http://www.drexplain.com


 

 

2.13.2. Animated PNG
 
Animated Png (APNG) is a more recent animated image format used for web pages but is now supported by most
web browsers. The main advantage over animated gif is that there is no restriction to 256 colours, which means
that the quality is often better, however, the file size is often higher. They also support semi transparency whereas
animated gif does not.

Click 'Export Animation' in the File menu and select Animated Png from the submenu. Then specify a file name
and location and click 'Save' to display the animated Png options. After setting the options, click 'Export' and wait
for the progress bar to reach the end. Open in a web browser to test the exported png (opening in the default
Windows image viewer will only show the first frame).

Make sure that the speed of your animation is correct when playing before Exporting the animation because the
same frame rate will be used when exporting the Png. This can be adjusted using the scroll bar next to the Play
and Stop buttons.
 

Animated Png export options
 
Height
The Height option allows you to specify the dimensions of the exported png. The default value matches the height
of the animation set in Options. The width is determined automatically from the animation aspect ratio. Note that
a larger value will increase the file size.

Loop
Select the Loop option so that the exported animation loops back to the beginning when it reaches the end. This
is recommended if the animation is to be used on web pages. If not selected then the animation will play once and
then stop on the last frame.

Smooth Edges
When enabled, the figures will have smooth anti-aliased edges as they do when editing. When disabled, the figures
will have jagged aliased edges, which is equivalent to exporting in Pivot 4 with Super Sample set to 1. Most of the
time you will want Smooth Edges enabled as it is by default. However, disabling may be useful if you want a more
retro look, to reduce file size or because you want to fill areas after exporting.
 
Transparency
Animated pngs can be exported with transparent regions so that they can be overlaid onto other components of web
pages while allowing the areas behind to be seen. Firstly set the background of the animation to solid transparent
using the background colour editor. Set the opacity to 0 when selecting the colour. Now when you export the
animation to animated png the visible areas of background will be transparent.

https://en.wikipedia.org/wiki/APNG
https://en.wikipedia.org/wiki/Spatial_anti-aliasing


 

 

If semi transparent backgrounds or figures are used then they will appear correctly as semi transparent over any
objects behind.
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2.13.3. Video
 
Videos provide the best quality output as a single file and can easily be uploaded to YouTube or other video sharing
site. Videos can also be edited in video editing software for adding additional effects, captions or audio. The Video
options enable you to select from various widely supported video formats depending on your preference.

Click 'Export Animation' in the File menu and select Video from the submenu. Then specify a file name and location
and click 'Save' to display the video export options. After setting the options, click 'Export' and wait for the progress
bar to reach the end. Open in a video player such as Windows Media Player or VLC to test the exported video.
 
Make sure that the speed of your animation is correct when playing before Exporting the animation because the
same frame rate will be used when exporting the video. This can be adjusted using the scroll bar next to the Play
and Stop buttons.
 

Video export options
 
Height
The Height option allows you to specify the dimensions of the exported video. The default value matches the height
of the animation set in Options, unless the animation height is less than 400, in which case the default height is
doubled to improve quality. The width is determined automatically from the animation aspect ratio. Use the HD
button to set a height of 1080 corresponding to High Definition video. A larger value will increase quality but also
the file size.
 
Supported Formats
WMV - Windows Media Video. Good compression and quality. Is supported by YouTube and most other video
sharing sites but may not be supported by some non Windows devices.

WEBM - Designed for use on the web. Good compression and quality for videos streaming. Is supported by YouTube
but not as widely supported by some video players or devices. This is the only format that supports transparency.

MP4 - Using MPEG-4 Part 2. This is an older format than the more recent and popular mp4 h.264 codec, which
is not currently implemented due to licensing restrictions. The compression and quality are still fairly good. This
format is the most widely supported in various video players, video sharing sites and devices.

FFV1 - Lossless avi video. The resulting video will have the same quality as playing the animation in Pivot. However,
the resulting file will be larger than the other formats. It is also not as widely supported by video players or by
YouTube. This is a good option if you plan to do further editing or adding sound in a video editor (as long as the
video editor supports FFV1). FFV1 videos can be played and converted using VLC media player. Bit rate is not
used for this format.

http://www.youtube.com
https://en.wikipedia.org/wiki/Windows_Media_Video
https://en.wikipedia.org/wiki/WebM
https://en.wikipedia.org/wiki/MPEG-4_Part_2
https://en.wikipedia.org/wiki/FFV1
https://www.videolan.org/


 

 

Windows AVI. This option offers a variety of video formats with extension .avi and gives the same result as video
export in Pivot Animator 4. Leaving the Compress option unselected will produce a large video with no compression
and no loss of quality, but be careful that you have enough disk space. Selecting Compress will show a Video
Compression options window after clicking Export, where a variety of settings can be chosen. Any additional video
codecs that you install under Windows will appear in the Compressor list. For example, Lagarith is a good free
codec to install if you would like no loss of quality, but with a much smaller file than uncompressed.

The AVI Video Compression options window, which is shown when Windows AVI is selected
 and the Compress option is chosen. The compressor list shows all codecs you have installed.

 
Bit Rate
The bit rate (measured in kilobits per second) can be set to vary the quality of the video output, where a higher value
typically gives better quality but also a larger file size. The default value of 1024kbps corresponds to 1 megabit per
second and provides good quality for any of the formats. Reduce the value if a smaller file is needed.

Note that increasing the value beyond a certain amount may not make much difference to the resulting video. If the
quality is too low even with a high bit rate then consider increasing the Height value.
 
The value can be typed in or increased or decreased by dragging right or left in the box or more quickly by
dragging up or down.
 
Smooth Edges
When enabled, the figures will have smooth anti-aliased edges as they do when editing. When disabled, the figures
will have jagged aliased edges, which is equivalent to exporting in Pivot 4 with Super Sample set to 1. Most of the
time you will want Smooth Edges enabled as it is by default. However, disabling may be useful if you want a more
retro look or because you want to fill areas after exporting.
 
Transparency
Most video formats do not support transparency, with the exception of WebM. If the animation uses a transparent
background then those areas will appear black in the exported video unless WebM is used. Even WebM will
appear black when played in most media players but will be transparent when shown on a web page or imported
into some video editing software. Consider exporting to Animated Gif or Png if transparency is needed.
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2.13.4. Separate Images
 
Saving as separate images will save each frame as a separate image file. This can be useful if you want to use
individual images on web pages or if you prefer to compile the images into a video or other file format using other
software. The Image options allow you to export in four popular image formats. The resulting image file names will
be given a suffix based on their frame number in the animation. A new folder will automatically be created to store
the images in if 'Create Folder' is selected.

Click 'Export Animation' in the File menu, select 'Separate Images' from the sub menu, specify a file name and
click 'Save' to display the Export as Images options window and save. After setting the options, click 'Export' and
wait for the progress bar to reach the end.
 

Image export options
 

Image Format
PNG - A compressed but lossless image format. This is the preferred pixel based format as there is no reduction
in quality but results in a relatively small file size.
JPEG - A compressed and lossy image format normally used for photos. This may be the preferred format if photos
are used for backgrounds or sprites and you want to minimise file size.
GIF - A compressed and lossy image format normally used for simple graphics, which only supports 256 colours
but results in a small file size if the animation contains few colours.
SVG - Scalable Vector Graphics format. This format is based on a description of the objects rather than pixels. The
result can be scaled to any size without loss of quality. SVG files can be viewed in most web browsers or edited in
a vector graphics software such as Inkscape. The files are XML based and so can even be edited in a text editor.
This is the best format to use if designing artwork using Pivot. If background or sprite images are included in the
frames, then they will be saved in a folder and linked to from the SVG file.

Quality
The JPEG quality with 100% being best quality and largest file size. This option is only enabled if JPEG is selected
as the Image Format.

Height
The Height option allows you to specify the dimensions of the resulting images. Leave the value as default if you
want the resulting images to have the same dimensions as your animation.

Create Folder
When enabled, a folder will be automatically created for you and the exported image placed in it. When disabled,
the images will be saved directly to the save location. It is better to leave Create Folder selected to reduce clutter
in the save location.

Smooth Edges

http://en.wikipedia.org/wiki/Portable_Network_Graphics
http://en.wikipedia.org/wiki/Jpeg
http://en.wikipedia.org/wiki/Gif
https://en.wikipedia.org/wiki/Scalable_Vector_Graphics
https://inkscape.org/
https://en.wikipedia.org/wiki/XML


 

 

When enabled, the figures will have smooth anti-aliased edges as they do when editing. When disabled, the figures
will have jagged aliased edges, which is equivalent to exporting in Pivot 4 with Super Sample set to 1. Most of the
time you will want Smooth Edges enabled as it is by default. However, disabling may be useful if you want a more
retro look, to reduce file size or because you want to fill areas after exporting. S

Transparency
All image formats apart from JPEG can be exported with transparent regions so that they can be overlaid onto other
components of web pages while allowing the areas behind to be seen. Firstly set the background of the animation
to solid transparent using the background colour editor. Set the opacity to 0 when selecting the colour. Now when
you export the animation as separate images the visible areas of background will be transparent.

If semi transparent backgrounds or figures are used then they will appear correctly as semi transparent over any
objects behind.
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2.14. Keyboard Shortcuts
 

Main Window
 
P -  Play animation (+Ctrl for Preview frame)
S -  Stop animation
B -  set Background from background selector
F -  add Figure from figure selector
E -  Edit figure type of selected figure
O -  center selected figure (move to Origin)
M -  flip / Mirror selected figure (+Ctrl for vertical flip)
C -  set Colour of selected figure
J -  Join selected figure to another figure
I - Input segment / figure position / camera values
Delete -  Delete selected figures
Shift+Up -  raise selected figure in draw order (+Ctrl for 1 step)
Shift+Down -  lower selected figure in draw order (+Ctrl for 1 step)
Arrow keys -  move selected figure (rotate segment if cursor over red handle)
Ctrl+Left or Ctrl+Mouse Wheel Down -  set selected figure to previous in the list
Ctrl+Right or Ctrl+Mouse Wheel Up -  set selected figure to next in the list
A / Space -  Add the frame or store the frame being edited
Ctrl+C -  Copy selected figure
Ctrl+V -  paste selected figure
Ctrl+Alt+D -  Delete selected frames
Ctrl+Alt+C -  Copy selected frames
Ctrl+Alt+V -  paste selected frames
<> or ,. -  store current frame and step to the previous/next frame
 
Ctrl+Drag Red Handle -  stretch segment (right mouse button to bend)
Alt+Drag Red Handle -  scale and rotate figure
Alt+Shift+Drag Red Handle -  scale figure without rotation
Alt+Ctrl+Drag Red Handle -  rotate figure without scaling
Alt+Z+Drag Red Handle -  rotate and scale multiple selected figures individually without separation
Alt+X+Drag Read Handle -  rotate and separate multiple selected figures without scaling
R+Drag Red Handle -  Re-position joint (Edit Mode) (right mouse button to bend)
Arrow keys when cursor over red handle -  rotate segment (Ctrl and Alt can be used in combination)
Shift+Arrow keys when cursor over red handle -  rotate segment to align with axes
Shift+Mouse Wheel when cursor over scale box - change the figure scale in small increments
L when cursor over handle - move figure or v-cam to align handle with previous frame (Shift to align with next
frame)
 
Ctrl+N -  New Animation
Ctrl+O -  Open Animation
Ctrl+S -  Save Animation
Ctrl+Alt+S -  Save Animation as
Ctrl+B -  load Background Image
Ctrl+Alt+B -  set Background Colour
Ctrl+I -  load Sprite Image
Ctrl+F -  load Figure Type (stk)
Ctrl+Alt+F -  open Figure Builder Window
Ctrl+T -  create Text Object
Ctrl+Z -  undo
Ctrl+Y -  redo
Ctrl+A -  select All figures
Ctrl+D -  Duplicate selected figures
Ctrl+Alt+O -  open Options window



 

 

 
+ or Mouse Wheel Up -  zoom in
- or Mouse Wheel Down -  zoom out
F1 -  scale to 100%
F2 -  scale to 200%
F3 -  scale to selected figures and center
F4 -  scale to animation area and center
F5 -  scale to 50%
F6 -  scale to virtual camera view
Drag with Mouse Wheel Down or Spacebar Down -  shift zoomed area
Ctrl+H -  show / hide Handles of unselected figures
Ctrl+K -  show / hide virtual camera viewport
Ctrl+Alt+K - reset virtual camera to default
F11 - Copy virtual camera of current frame
F12 - Paste virtual camera into current frame
 
Ctrl+Alt+H -  go to pivot Help files web page
Ctrl+Alt+R -  view Readme file
Ctrl+Alt+A -  open About window
 
Figure Builder Window
 
C -  add a Circle Segment
L -  add a Line Segment
P -  add Polygon
D -  Duplicate selected segment (+Shift for the whole branch, +Ctrl for mirror)
K -  change the Kind of the selected segment (line/circle)
F -  change the Fill of the selected circle
E -  change the End cap of the selected line
Up/Down -  thickness +/-1 (+Shift for the whole branch, +Ctrl for +/-5)
S -  make the selected segment Static/dynamic (+Shift for the whole branch)
O -  set Origin joint of the figure at selected segment
Insert -  split selected segment by Inserting a joint (+Shift for the whole branch)
Delete -  Delete selected segment or polygon (+Shift for the whole branch)
H -  set colour (Hue) of selected segment or polygon (+Shift for the whole branch, +Ctrl for gradient colour)
M -  flip (Mirror) the selected segment (+Shift for the whole branch, +Ctrl for flip vertical)
Right Arrow -  raise selected segment or polygon in draw order to top (+Shift for the whole branch, +Ctrl for 1
step)
Left Arrow -  lower selected segment or polygon in draw order to bottom (+Shift for the whole branch, +Ctrl for 1
step)
I - Input segment values
 
Ctrl+Drag Red Handle -  stretch segment
Alt+Drag Red Handle -  scale and rotate figure
Alt+Shift+Drag Red Handle -  scale figure without rotation
Alt+Ctrl+Drag Red Handle -  rotate figure without scaling
R+Drag Red Handle -  Re-position joint (Edit Mode)
Arrow keys when cursor over red handle -  rotate segment (Ctrl and Alt can be used in combination)
Shift+Arrow keys when cursor over red handle -  rotate segment to align with axes
 
Ctrl+N -  New figure
Ctrl+O -  Open figure
 
Ctrl+S -  Save figure
Ctrl+Alt+S -  Save As
Ctrl+A -  Add figure to animation
Ctrl+I - load sprite Image



 

 

Ctrl+Z -  undo
Ctrl+Y -  redo
Ctrl+T -  make window Transparent / opaque
<> or ,. -  decrease / increase window transparency
Ctrl+W -  increase outline thickness (Width)
Ctrl+Q -  decrease outline thickness
Ctrl+E -  Edit mode
 
+ or Mouse Wheel Up -  zoom in
- or Mouse Wheel Down -  zoom out
F1 -  scale to 100%
F2 -  scale to 200%
F3 -  scale to selected segment or polygon and center (+Shift for whole branch)
F4 -  scale to whole figure and center
F5 -  scale to 50%
F8 - Match main Canvas Pan/Zoom with the figure builder pan/zoom when in transparent window mode
Drag with Mouse Wheel Down or Spacebar Down -  shift zoomed area
 
F12 - Highlight Selected Segment
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2.15. Language Files
 
Pivot Animator supports multiple languages that determine how captions and messages are displayed within the
program.

  The language can be set from the options window.
 
Creating Language Files
If you are fluent in English and another language and would like to translate Pivot to that language then you can
create your own language file for Pivot. You can then send the language file to others who speak that language
to make it easier for them to use Pivot.

The language files can be found in a folder called 'languages' in the location that the Pivot program was installed
to. This is normally in C:\Program Files (x86)\Pivot Animator\languages.

Open the English.ini file and read the instructions at the top of the file. Translate all text to the right of an '=' sign
and save as a new INI file with the name of your language. Be careful when translating text with a name to the left
of the '=' ending in 'Cap' so that you do not increase the length of the text too much.

For languages using extended character sets, such as Chinese, Russian or Greek, make sure to save the .ini file
in UCS-2 LE BOM format. Pivot will then be able to load the Unicode characters correctly. This options can be set
using Notepad++ from the Encoding menu.

After translating the file, test it in Pivot making sure you check all windows.

If you create a language file then please send it to support@pivotanimator.net so that it can be included in future
Pivot Animator releases.
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2.16. Things You May Not Know
 
In order to keep the interface as simple as possible there are several features in Pivot Animator that are not
immediately obvious. Many of these features can only be used with the knowledge of specific keyboard keys. Most
of these features are mentioned elsewhere in this user guide but have been collected together here to make them
easier to find. If you've already learnt the basics of using Pivot Animator then it may be worth reading this list to
learn to do things you may not know about yet, or just to make the process of making animations easier.

Positioning Figures
1.   Stretch segments while dragging using the Ctrl key
2.   Reposition joints between segments while dragging using the R key
3.   Bend line segments by Right click dragging
4.   Rotate a segment in small increments using the arrow keys with the cursor over a handle (zoom in for finer
adjustment)
5.   Position segments accurately by clicking down on a handle and then moving the cursor far away before
releasing
6.   Align a segment to horizontal / vertical using Shift + arrow keys with the cursor over the handle
7.   Align handles with the previous frame using the L key (+ Shift for next frame if editing a frame)
8.   Resize and rotate the whole figure using the Alt key (+ Ctrl for rotate only, + Shift for scale only)
9.   Scale a figure in small increments by holding the shift while rotating the mouse wheel over the scale box

Multiple Figure Selection
1.   Change a figure between selected or unselected by clicking it while holding the Shift key
2.   Select a group of joined figures by double clicking the figure at the base of the tree
3.   Resize and rotate all selected figures together using the Alt key
4.   Scale and rotate all selected figures as separate objects (lock their positions) using Alt + Z
5.   Lock the scale of selected objects so they only rotate and move apart using Alt + X

Selected Figure Controls
1.   Flip a figure vertically using the flip button while holding the Ctrl key
2.   Scale a figure quickly by dragging in the scale box or using the mouse wheel while the cursor is over it
3.   Change the figure's z-order in single step increments using the raise / lower button while holding the Ctrl key

Canvas Zoom
1.   Zoom and scroll quickly using the mouse wheel (rotate or click and drag)
2.   Use View menu items quickly using the F key shortcuts (see the View menu)

Timeline / Frame controls
1.   Show the time of the current frame from the start of the animation by hovering the cursor over the frame
number
2.   Select multiple frames using the Shift or Ctrl keys in the same way as multiple files are selected in Windows
Explorer
3.   Set the background or inbetweens value for multiple frames by multi-selecting, making the change and
then clicking Update Frame
4.   Step through frames quickly using the < and > keys
5.   Add a frame quickly using the space bar or A keys
6.   Undo all changes to a frame being edited by clicking the frame again in the timeline

STK files
1.   See a preview of the selected figure in the open figure window by clicking the preview button in the top
right corner
2.   Save as a v2 or v4 format STK file by clicking Save As in the figure builder and selecting a type from the
dropdown list

Figure Builder



 

 

1.   Create invisible connections between segments by adding a line segment with thickness set to 0 and adding
another segment to it
2.   Apply segment control changes to a whole branch by selecting the segment at the base of the branch and
holding the Shift key
3.   Flip a segment or branch vertically by using the Flip button while holding the Ctrl key
4.   Change the segment's z-order in single step increments using the raise / lower button while holding the Ctrl
key
5.   Make sub-pixel adjustments to segment or outline thickness by zooming in first
6.   Add multiple polygon connections with one click by holding the Ctrl key to include all points between the
previous point and the clicked point

Inbetweening
1.   Hide keyframes while playing by setting inbetweens value to -1 (used as reference only)
2.   Inbetweening between different backgrounds or different figure colours will create a fade effect
3.   If inbetweening doesn't work because figure IDs don't match then delete the figure and copy and paste it
from the other frame
4.   Create a sudden change in direction when auto-easing is enabled by separating inbetweened frames into
groups

Text Objects
1.   Add non-alphanumeric objects using symbol fonts such as Webdings
2.   Add non-alphanumeric objects using Alt codes or unicode characters by copying and pasting them into
the text box
3.   Create an ellipse object by writing a full stop in the text editor, adding it to the animation and then stretching
it using the Ctrl key

Virtual Camera
1.   Show or Hide the Virtual Camera quickly using Ctrl + K
2.   Set the position, rotation or scale to match the previous frame by placing the cursor over a handle and
using the L key
3.   Position the camera accurately by placing the cursor over a handle and using the arrow keys (zoom in for
finer adjustment)

Export
1.   Export an animated gif or png with a transparent background by using a solid background with opacity
set to 0 in the background colour selector
2.   Convert to many other video formats by exporting as lossless FFV1 video and then converting using VLC
player
3.   Export to separate SVG images to create high quality vector art that can be edited in Illistrator or Inkscape

Hidden Accessibility Settings
1.   Make the default handle size larger by increasing HandleMaxSize and HandleMinSize in the Pivot.ini file
(found in AppData\Roaming)
2.   Change the colour of handles by setting HandleColSeg, etc in the Pivot.ini file. Hex colour ordering is BGR
3.   Change the colour of the selected frame highlighting by setting SelectedFrameColor in the Pivot.ini file.
Hex colour ordering is BGR
4.   Increase the number of digits after the decimal point in the status bar info by setting InfoBarPrecision
between 1 and 4 in the Pivot.ini file
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